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Introduction  
 
The intent of this document is to provide instructions for utilizing a Trimble Geo7x GPS 
unit for field data collection. The instructions include: 
 

• An overview of the Trimble Geo7x 
• An overview of Windows Mobile 6.5 
• An overview of Windows Mobile Device Center 6.1 
• Functional steps for using ArcPad  
• Data Collection settings and standards 
• Data Processing techniques 

 

Overview of the Geo7x 
 

Global Positioning System (GPS) Technology  
 
GPS is a satellite based radio-navigation system.  Satellites in 
the earth’s orbit send signals that a GPS receiver can use to 
determine position, velocity and time.  GPS provides world-wide 
coverage, is continuous and uninterrupted, and is available in 
any weather conditions, day or night. 

 

Hardware  
 
The shipping box from Trimble includes the Geo7x device and related accessories such 
as a carrying case, a Lithium Ion battery pack, AC power supply and adapters, USB 
data cable, a Quick Start Guide brochure, hand strap, screen protector and labels, and 
extra stylus.  Most of those accessories have already been installed for your 
convenience. 
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The Geo7x has 256 MB of internal memory and 4 GB disk storage. It is equipped with a 
slot for an internal SD card. It utilizes Floodlight technology for better reception under 
canopy. The Geo7x provides real-time differential GPS capability utilizing Space Based 
Augmentation Services such as the Wide Area Augmentation System (WAAS) for 
correction support.  This simply means that a correction from a WAAS satellite can be 
received and applied to the GPS satellite information your unit is receiving to obtain a 
more accurate (sub meter) position.   The Geo7x integrates GIS capabilities. Many of 
the GIS processes that used to be done on an office workstation can now be done in 
the field. When fully charged, the Geo7x can last between 7 to 10.5 hours, depending 
on the number of features being used.  The casing of the Geo7x is dust-proof and 
resistant to heavy driven-wind.  Online tutorial for GPS is available: 
http://www.trimble.com/gps_tutorial/index.aspx 
 
 

Software  
 
In order to use the procedures contained in this document, the following software is 
needed:  
 
On the handheld device: 

• ArcPad 10.0 R4 or greater 
• Microsoft Windows Mobile 6.5 or greater 

On the computer: 
• ArcMap 10.0 or greater 
• Windows Mobile Device 6.1 or greater.  

 
NOTE:  The mention and/or use of any software contained in this document should not 
in any way be considered as an endorsement by USDA-NRCS.  
  

http://www.trimble.com/gps_tutorial/index.aspx
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Features of the Geo7x 
 
This section gives a brief overview of the unit and how to use the basic features. 
 

 
 

Button descriptions 
Power : Used to turn the unit on and off.  Press and release the 

Power button to turn on or off (suspend) the unit.  If 
unit is on, tap the Power button on the HOME screen 
to suspend, soft reset, or shutdown the unit.   

 
Suspending puts the device puts to sleep, and when it 
is turned back on, the device remembers where it was. 
Some battery power is used. 

 
Shutdown closes all programs and turns off all of the 
power. No battery power is used. 
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Hard reset:  Retains settings and data previously saved.  Any unsaved data may be 
lost.  A hard reset should only be done if a soft reset does not resolve 
problem.  To perform a hard reset: 

a. Hold down the Power/Home button on the keypad for at least 10 
seconds until the Trimble logo screen appears 

b. Release Power/Home button 
 
Factory reset:  This procedure should be used if both a soft reset and a 

hard reset do not resolve problem.  CAUTION: this procedure 
erases all data, installed applications and settings stored on the 
Geo7x, the encryption key for any encrypted file stored on a 
memory card. To perform a factory reset: 

1. Hold down the Power/Home button on the keypad 
2. When the Trimble logo appears, immediately press and hold both 

the left and right application keys 
 

 
 
 
 
 
 
  

3. Release the Power/Home button.  Instructions will appear on the 
screen 

4. Release the application keys 
5. Follow the on-screen instructions to continue the factory reset 

 
 

Camera/Video:  Press camera button in center of 
keypad to launch camera or video application. 
If that button has been programmed for a 
different task, click on START > Pictures & 
Videos > Camera.  See Appendix A for further 
instructions on using camera/video features 

 
 

Safety Measures for the Geo7x unit 
 
The following precautions should be observed when using the Geo7x unit. 
 

1) Use only accessories intended for the Geo7x. 
 

2) Do not open the casing of the Geo7x as this voids warranty. 
 

3) Touchscreen is susceptible to breakage. Use a light touch. 
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4)  Do not store or leave the handheld near a heat source or otherwise 
expose it to temperatures in excess of 70 °C (158 °F) such as on a 
vehicle dashboard. When heated to excessive temperatures, 
battery cells could explode or vent, posing a risk of fire. 
 

5) Clean unit with a damp cloth – do NOT immerse. 
 

6) Make sure SD card slot is securely closed to avoid exposure to 
environment.  A SD or SDHC (high capacity) card may be used 
with the Geo7x.  Do not store files at the root level. 
 

7)  Use Trimble authorized Dealer repair facility. 
 

 

Proper Handling Techniques  
 

1) Hold unit so antenna is parallel to earth and sky 
 

2) Hold away from body to minimize masking 
 

3) Hold unit at about mid torso 
 

4) Do not cover antenna 
 

5) Use handstrap to avoid dropping the Geo7x accidentally 
 
 

6) When in full sunshine, position yourself with back to the sun so light 
comes from behind and above shoulders.  Tilt unit to avoid direct 
reflection of sunlight off the touchscreen and improve readability.  
Changing the screen brightness level may also be useful. 
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Overview of Windows Mobile 
The operating system used by the Geo7x units is MS-Windows Embedded Handheld 
version 6.5 Professional.  This section provides basic instructions on using this 
operating system and would therefore be applicable to devices other than the Trimble 
Geo7x (e.g. ProXYZ, GeoXM, and Juno) that utilize the same operating system. 

Touchscreen 
 
Tap :  This term will be used in this document to refer to the action of using the 
stylus to select an item on the screen by gently tapping the stylus on the 
touchscreen.  This would be like double-clicking with a mouse on the desktop 
screen.  
 
Tap and hold :  This describes the action of gently applying pressure and 
holding the stylus on the touchscreen until something happens (e.g., context 
menu appears).  You can think of this as the method of right-clicking that you do 
with a desktop computer mouse. 
 
Tap and drag :  This describes the action of gently applying pressure and 
dragging the stylus across the touchscreen without lifting the stylus.  This 
technique is typically used when moving a vertex on a line or polygon feature in 
ArcPad. 
 
Calibrating :  If the touchscreen is not responding correctly to taps, you may 
need to calibrate the screen.  Tap Start > Settings > System > Screen > Align 
Screen and follow prompts.  When done, tap OK in upper right to close screen 
window.  Tap X in lower right to close System window. 
 
Keyboard :  When you need to enter any data (i.e., numbers or characters), you 
should see a small keyboard icon near the bottom of the screen.  Simply tap this 
icon and an on-screen keyboard should appear.  Tap the icon again to hide the 
keyboard. 
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Home Screen 
 
When turning on your unit, you will be presented with a customized Home screen.  The 
“Home” screen functions similarly to the Windows desktop on your computer and will 
look similar to that shown below.  The most useful items shown in the screen shot are 
explained below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Start menu:  Tapping this provides access to programs, files, and settings on the 

device similar to clicking the Start button on your desktop computer. 
 

Soft keys: These are context-sensitive keys that will allow you to perform various 
actions or open menus.  Simply tap on the desired one to activate. 

Backlight: Click on Backlight icon  to adjust settings for screen brightness and 
timing to turn backlight on or off based on user actions or duration of user 
inactivity.  

File Explorer: Click on Explorer icon  to manage files stored on the handheld disk 
or a storage card.  More details on this topic later. 

GPS Controller: Click on Controller icon  to launch interface and access Skyplot 
menu to view Horizontal Accuracy or Setup menu to verify/adjust settings 

 

Settings toolbar:  Tap anywhere to access additional icons that indicate the operating 
conditions of various items on the device.  Some examples include: 

: Connection.  Tap to view or modify connection settings.  

: Clock & Alarms.  Tap to set volume level or to turn on/off speaker. 

Status icons 

             Today’s date 

ArcPad shortcut 

 Primary Apps shortcut 

Soft keys 

   Settings toolbar 

Active Programs 
          Start menu 
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  : Battery level.  Tap to view or modify power settings. 
 

 

 General Settings 
Various settings can be accessed by using the Start 
Menu and selecting “Settings”.  Some settings you 
might have a need to change are Personal (owner’s 
information; input preferences), System (screen 
orientation, screen alignment, text size).  These are all 
found on the “System” page of the Settings window. 
 
 
 
Memory and Power Management 
 
The distribution of memory capacity can be viewed through the Start > 
Settings > System > Memory icon.  The Main tab shows the amount of 
memory available on the Geo7x unit.  The Storage Card tab shows 
available memory on an SD or SDHC card, if present.  Recommended 
memory management practices include: 
 

1) Close Programs before opening new programs 
2) Use patience when working with large datasets 
3) Use soft resets at beginning of each work day 

 
The amount of power available can be viewed through the 
Start > Settings > Power icon.  The Battery tab shows a 
power scale indicating amount remaining.  The Advanced 
tab allows users to adjust the frequency of automatic 
timeouts (system suspension). Recommended power 
management practices include: 
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File Explorer 
 
The File Explorer application allows you to perform file management functions (e.g., 
copy, move, delete, rename, etc.) on the device just as Windows Explorer does on your 
desktop computer.  (Note: Since filenames are often truncated because of the small 
display, you may find it easier to do file management using the Windows Explorer 
application on your desktop computer.  This is explained later). To start the File Explorer 

application, Click on Explorer icon  on the Home screen or Tap Start > File 
Explorer. A window similar to that shown below should appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Navigating:  Tap a folder to open that folder.  Tap Up at bottom of screen to move up 

to parent folder.  Use the current folder drop-down to move back up to a higher 
folder or to switch between the SD Card and My Device. 

Opening:  If you Tap on a file that has an associated application, the application will 
load and open the selected file.  If there is no associated application, an error 
message will display. 

Copying, cutting (i.e., moving), deleting, renaming:   Tap and Hold on a single 
file/folder or on the highlighted files/folders (see above).  A context menu should 
pop-up.  Select the desired action (e.g., copy, cut, delete, rename).   
 
To Delete, answer yes or no to confirm the prompt. 

To Rename (single files only), bring up on-screen keyboard  and enter new 
name. 
To copy or move a file to desired folder; Tap and Hold in an empty area of the 
screen (or use Context menu button, or select Menu > Edit at lower right) and 
select Paste from the pop-up menu. 

Current folder Sorted by 

Files and 
folders list 

Move up a folder Menu of actions 
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Selecting multiple files/folders:    Use the Ctrl key on the virtual keyboard and 
select or unselect individual files not listed sequentially in Explorer.  Likewise, use 
the Shift key to highlight groups of files and/or folders 

Creating a new folder:   Select Menu > New Folder at lower right of screen.  You may 
need to scroll down to see this and other options.  Bring up on-screen keyboard 

 and enter new folder name. 
 

PRACTICE: Complete Activity #1 in Appendix K 
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Overview of Windows Mobile Device Center 
 
In order to communicate (i.e., download and upload) with a desktop computer, Windows 
Mobile Device Center (WMDC) software (ver. 6.1 or newer) needs to be installed and 
running on the desktop computer.  If WMDC is running, you should see this icon  in 
the lower right of your screen.  If the icon is not there, you will need to start WMDC by 
selecting Start > All Programs > Windows Mobile Device Center. 

Establishing a connection 
Using the provided USB cable, plug the “small” end of the cable (USB type Mini-B) 
into the USB port of the Geo7x.  With the computer on and logged into your 
desktop, plug the “flat” end of the cable (USB type A) into a USB port on the 
computer. Turn on GPS device. 
 

 
If this is the first time you have connected the device to this computer, you may 
see some messages displayed in “yellow bubbles” near the lower right of your 
monitor about finding new hardware.  You will need to allow this process to 
complete and for a message to display that the hardware is installed and ready to 
use before proceeding. 
 
WMDC should recognize you have connected a device.  If so, a “Synchronization 
Setup Wizard” window will appear as shown at right. 
 
Click [“Connect without setting up your device].  
The device will connect as a “guest”.  You will be 
able to copy and move files between the device 
and your computer.  This is the recommended 
choice if the device will be used by multiple 
people and/or connected to multiple computers.  
You should then see a screen similar to that 
below showing the option to launch Windows 
Explorer. 
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Bring cursor on File Management option 
and click on “Browse the contents of your 
device to open a Windows Explorer session 
showing the root directory of the Trimble 
Geo7x. The option to “Setup your device” , 
i.e. synchronize the Geo7x with user’s 
contacts, calendar, email etc. is not 
recommended if more than one person is 
using the Geo7x in an office. 
 

 

Transferring files between computer and device 
Once Windows Explorer is open, it will normally display the root level directory on the 
device from where you can access subfolders on the Geo7x’s memory and storage 
card, if available.  Note also that 
the amount of available memory 
on the Geo7x and storage card 
is also shown. 
 
You can now navigate the 
folders and perform the usual file 
management actions (i.e., copy, 
rename, delete, etc.).   

 
To help in navigating folders, you 
need to click  on the 
toolbar to open a folder tree in 
the left window. 
 
This single explorer window can 
be used to copy files between the 
device and your computer using 
the Copy (Ctrl-C) and Paste (Ctrl-
V) method.  You might find it 
easier, however, to open a 
second Windows Explorer 
session and navigate to the 
desired folder on the computer.   
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Tip: An easy way to open an explorer windows is to use the  + E shortcut (on your 
keyboard, hold down the windows key  and then press E).  You now have 2 
windows that you can drag and drop files and folders from one window to the other to 
copy them (see below).  
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Recommended folder structure for workstation and SD Card 
A single directory (GPS_data) should be created under the C:\Users\<first 
name.last name>\ folder for the purpose of transferring client folders to and from 
the Geo7x.  This will minimize the risk of having multiple folders for an individual 
user scattered throughout the workstation, and facilitate importing features by 
multiple users on the same workstation. To create a folder from Windows Explorer, 
open the desired parent folder and then select File > New Folder.               

 
Florida-NRCS has procured an SDHC card 
for each Geo7x unit.  This allows for 
storage of county wide datasets and 
customer folders on the card which 
facilitates data management.  To provide 
some consistency in file management, the 
structure and naming conventions of the 
geospatial dataset collection on service 
center servers (F:\geodata) should be 
replicated on the SD card of the Geo7x. It 
is recommended to copy only data 
categories needed for field work.    
Customer folders should be stored right at 
the root level of the SD card as shown in the screenshot on the right. Note also the 
‘geodata’ folder and its contents. 

 
PRACTICE: Complete Activity #2a in Appendix K 
 

Exporting Customer’s field boundary with ArcPad Data Manager 
 
GIS datasets for a customer can be prepared on your workstation in ArcMap and then 
packaged for transfer onto the Geo7x.  In ArcMap, load layer containing field 
boundaries (e.g. PLU from Toolkit).   
  
The ArcPad Data Manager (ADM) is an application 
available in ArcGIS 10 to create folders containing 
layers for transfer onto the Geo7x.  To activate 
ADM in ArcGIS for the first time, click on Customize 
> Extensions and add a checkmark next to ArcPad 
Data Manager on the list of available extensions. 
Then click on Customize > Toolbars > ArcPad Data Manager. NOTE: The ADM can be 
used to export features from ESRI shapefiles and Toolkit’s Active PLU, not the Case 
PLU at this time. Instructions for using the Case PLU are provided in the next section. 
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a.  Click on Get Data for ArcPad button  
 
  

 

b. Select appropriate “Action” 
for each layer 

 

 

c. You may skip next 
screen for Picture 
Options 
  
  
 
 

d.  Select Output Options: Spatial 
Extent, name for customer 
folder to be created [e.g. 
DataFor<Customer Name>], 
directory to store customer 
folder.  
 

e. Click the Browse icon to select 
the path where the customer 
folder will be saved, i.e. 
C:\Users\ <user.name>\ 
GPS_Data,  

 
f. Enter name of *.apm file for quick access on handheld unit. 

 

g. Select Deployment 
Option: Create 
ArcPad data on your 
workstation 
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h. A report will be presented 

when process is complete: 
 

Click [Finish]. 
 
 A report will display the results of 
this process.  You may want to verify 
that the layer(s) exported are visible 
in an ArcMap document. You may 
also want to set the symbology of 
the exported layer(s) to remove the 
default color fill.   
 
 
Note that exported layers will inherit the projection of the data frame in ArcMap.  
The folder created can be transferred to the root level directory of the SDHC card 
using instructions provided in the ‘Transferring files between computer and device’ 
section.   
 
It’s worth noting that additional layers can also be exported to the customer folder 
for transfer to the Geo7x by selecting any of the layers listed in the ‘Get Data for 
ArcPad’ dialog box. The spatial extent of layers exported can be specified, if 
needed.  Keep in mind that when an image subset is created, there is a maximum 
area that can be included in the current display extent.  This area is dependent, 
among other things, on the resolution of the image you are using.  A rough guide 
of the maximum areas is as follows: 
 

Image Resolution Max. Area, acres Square Dimensions, miles 
1 meter 4,000 2.5 x 2.5  
2 meter 16,000 5 x 5 

2 ft. 1,500 1.5 x 1.5 
 
An alternative for accessing imagery on the Geo7x is to copy countywide 
orthomosaics on the SDHC card, with the understanding that using very large 
image files may slow speed of display.  This copying process is better done by 
inserting the SDHC card directly into a workstation due to the size of most county 
orthoimagery. 
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Exporting Customer’s field boundary without ArcPad Data Manager 
 
If you want to export features without using ADM (as is now required for features in 
the Case PLU, Toolkit v.8), follow these next steps: 

 
 

a) Load dataset in ArcMap 
 

b) Using the Select Features 
button in ArcGIS, select fields 
from desired layer (e.g. Case 
PLU) 

 
 
 

c) Right-Click on dataset then 
select Data-> Export Data 
 
 
 
 
 
 
 
 
 
 
 
 

d) Click the radio button to set 
coordinate system to be the 
same as the data frame 
 
 

e) Click on the Browse button to 
navigate to your C:\Users\ 
<user.name>\ GPS_Data 
folder 
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f) Click on ‘New Folder’ button to 

create a new customer folder 
under GPS_Data and enter 
name, e.g. DataforJohnSmith. 

 
 
 
 
 
 
 
 
 
 
 
 
  

g) In Saving Data dialog box open 
(double-click) the newly created 
folder and set file type (‘Save as 
type:’) to Shapefile and enter a 
name that may include the tract 
and field numbers. 
 
 
 
 
 
 
 
 

h) Click the Save button 
and when the process is 
completed, add the new 
shapefile to ArcMap by 
answering “yes” to the 
prompt.  This will help 
you verify that the 
layer(s) exported are 
visible in an ArcMap 
document 

 
 
 

i) Close ArcMap session before transferring customer folder to 
the root level of the SDHC card. Note that an ArcPad.apm 
document is not created in the customer folder using this 
method to export features 

 
PRACTICE: Complete Activity #2b in Appendix K 

  



Technology Technical Note GIS & GPS FL-08 

 - 23 - 05/17/2016 

 

Working with ArcPad – Part I 
 

Remember to check the battery power level the day before you plan to use it.  If it is 
low, you can charge it overnight using the AC adapter provided. 
 
ArcPad will be used in collecting data while in the field.  With this application comes the 
ability to collect more information (i.e., attributes) on features in the field.  Let’s take a 
preliminary look at ArcPad to better understand how it works before jumping into actual 
data collection. 

ArcPad Overview 
To start ArcPad, you can either tap the ArcPad icon on the HOME screen or select 
Start > ArcPad 10.0.  You will then be presented with different options for starting a 
session.  
 
If you have transferred a customer folder on the Geo7x unit, 
you can select the “Choose map to open” to get a list of 
available ArcPad documents (*.apm).   
 
The “Open last map used” will recall the last *.apm file used.  
Otherwise, you can start a new document with the “New 
map” option. 
 
 
 
 
 
The “Choose map to open” shows the screen below.  
In this window, you can: 
 
- Click on *.apm file to open the map document 

for a customer folder transferred 
 
-  Tap the Browse “folder” icon   to look for other 

documents not listed on this page 
 
 
 
 
 
 
 
 
 
 

Map 
thumbnails 

Map list 

Open selected map 

Open new empty map 
Create QuickProject 

Display recently used maps 

Browse 

Add layers 
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Notice that once an ArcPad document is selected, a snapshot of that document is 
displayed in the upper area of the dialog box.  Click OK.  The PLU and other layers 
exported will automatically be loaded. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The ArcPad user interface has three principal toolbars: Main, Browse and Edit as 
shown below. Each toolbar contains several tools that perform different tasks.   
 
 
The Main toolbar has tools to open/save/close 
ArcPad documents, manage GIS data layers, 
initialize GPS, and control ArcPad settings. 
 
 
 
 
The Browse toolbar has tools to zoom in/out 
manually or by a predetermined extent, to query 
attributes of features, or to find the location of a 
feature based on its attributes. 
 
 
 
The Edit toolbar has tools to select a layer for 
capturing GPS coordinates, select features for 
editing, adding points, lines or polygon features to 
layers, and manipulate existing features. 
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To save an ArcPad Document click on the 
drop-down arrow of the ‘Open Map’ icon, then 
select ‘Save Map’ or ‘Save Map As’ options 
 
 
 
 
 
 
 
 
 
 
 
 
Be aware that the ‘Save Map As’ option offers the 
Geo7x’s Main Memory as default storage location.   
 
 
 
 
 
 
 
 
 
 
 
You can change that location to the SD card by using the 
drop-down arrow in the ‘Location’ window.  Likewise you 
can choose the appropriate folder on the SD card and 
enter a name for the document. For instance, in the image 
on the right, the “Location” is set to Storage Card;  
“Folder” to DataforPMC and “Name” to PMC_inventory. 
Tap Save.  It will be saved with an  .apm extension 
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To exit ArcPad, Tap  ArcPad’s “quick 
action” icon and select “Exit”. 

 
 
 
 
 
 
 
 
 
 
 
Some basic ArcPad help can be found by 
tapping the drop-down arrow on the help icon 
(blue/white question mark) on the Main toolbar and 
selecting  Help > Quick Reference Help.  
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Editing Symbology 
 
The PLU file loaded in ArcPad may have a default solid color fill. That color fill can 

be changed either in ArcMap on your workstation prior to transferring a 
customer’s folder to the Geo7x or in ArcPad using the following steps: 

 
- Tap the ‘Table of Contents’ icon on the Main 

toolbar   
 
 
 
 
 

- Please note that the checkbox next to a layer’s name in 
the first column of the Table of Contents allows you to turn 
on/off a layer in ArcPad’s display window 
 
 

- In ArcPad’s Table of Contents, select the PLU then 
click on Legend tab  
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- Click on PLU Symbol to open the Symbol Properties window then 
click on Polygon Style tab  

 
     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- If the “Fill Polygons’ checkbox is greyed out, 

click the “Set to Default Fill Style” button 
 

- Uncheck ‘Fill Polygons’ , set outline to 2   
 

- Click on ‘Outline Color’ symbol 
 

- Select an outline color, if desired 
  

-  Click ‘OK’ to close ‘Symbol Properties’ and 
Table of Contents’ dialog boxes 
 

- Click ‘OK’ to exit Table of Contents 
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Adding existing layers to map 
 

You may want to add an existing shapefile, 
imagery, street map or other reference layer 
to your map.   
To add a layer, tap the “Add Layer” icon  
 
In the “Add Layer(s)” window, find the item or 
items you wish to add (you will need to tap 
the “+” next to a folder to expand it).  Check 
the box to the left of the desired item(s). 
The example at right shows a raster file and a 
points shapefile as selected. 
 
Note: Adding a checkmark next to a directory 
will automatically select all files stored under 
that directory!! 
 
 
 
 
 
 
Tap OK. 
 
The selected layer(s) will then be displayed. This can also be verified by viewing the 
listing of layers in the Table of Contents.  For more information about the Table of 
Contents, see Appendix B 

 

                 
 
PRACTICE: Complete Activity #3a in Appendix K 
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So far, we’ve started using ArcPad on the Geo7x using a map document (e.g. 
ArcPad.apm) previously created and stored in the customer folder.  We’ve used tools on 
the Main toolbar to add layers, view the table of Contents and manipulate symbology. 
 
Next, we’ll consider the case where a customer folder has been created without using 
the ArcPad Data Manager, and therefore a default *.apm file is not available.   
 
Once that customer folder is transferred to the root level of the SDHC card using 
instructions provided in the ‘Transferring files between computer and device’ section, 
launch a new ArcPad session.  Then choose “New Map”. Additional features of ArcPad 
will be discussed. 
 
.   
 

 
 
 
 
 
 
 
 
 
 
 
This will open a new ArcPad document into which the customer boundary shapefile and 
other layers can be added, as shown below.  Click OK. 
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The view on the screen is zoomed out to the extent of the largest layer, the county 
orthoimagery.  The Browse toolbar has options to focus or zoom the view to a smaller 
area such as the field boundary shapefile. 
 
Click on the Browse toolbar. Click the ‘Fixed Zoom’ dropdown and select ‘Zoom to 
Layer’.  This option opens a menu from which the layer of interest can be selected and 
brought in the center of the display.  Symbology can be edited as previously shown. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
Manual Zoom options can be accessed from the Browse toolbar or the Map Navigator: 

  
   
 
 
 
 

 
PRACTICE: Complete Activity #3b in Appendix K 
  

Map Navigator  

Manual Zoom Options on Browse 
Toolbar 

Previous Extent button has options 
to set or change geographic 
windows 
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Collecting Data 
 
In addition to customer folders and the geodata 
folder, each SD card has a folder 
(MasterProject<utm_zone>) which contains a set 
of three shapefiles representing each possible 
type of spatial feature: points, lines, and 
polygons.  <utm_zone> represents the 
appropriate UTM North zone for Florida, either 16 
from the western boundary of Jefferson to the 
western boundary of Escambia County or 17 for 
the remainder of the state. For more information 
on projections, see Appendix C. 
 
Those shapefiles have been customized such 
that when a feature is added, a list of resources 
and practices is presented in the attribute form to 
facilitate data entry. Note that ArcPad offers 
options to create shapefiles not discussed here.  
For more information, see Appendix D 
 
 
 
Once you add a shapefile from the MasterProject<utm_zone>, you are ready to collect 
some data.  To begin collecting data, you need to make sure the shapefile is open for 
editing.   
 
To do this, select the “Edit” toolbar. 
Tap the “Start/stop edit” pencil icon. 
Tap the desired layer to start or stop 
editing.  A red box around the icon 
indicates it is in edit mode. 
 

Adding features without GPS 
 
To add features manually to your map, you 
should first select the sketch tool for the 
appropriate feature type (e.g. point, polyline, 
polygon, etc).  To do this, tap the drop-down 
arrow on the third icon on the Edit toolbar.  
Only the sketch tools that pertain to the feature 
types you are working on are selectable.   
 
The icon should then change to the selected 
feature in an orange square. 
 

Edit toolbar Start/stop edit 
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NOTE!  Be very careful in using this.  It can be quite 
easy to inadvertently record an unwanted feature (e.g. 
point) by simply tapping on the screen.  This technique 
might be useful in setting a general navigation point, 
but should be avoided for collecting actual features.   
 
You can now tap on the desired location on your map 
to add the feature (e.g. point, vertex of a polyline, etc.).   
 
For a point, it will then bring up the form for you to 
enter related data (i.e. Name, Comments etc. - see 
example at right).  Note that if the name of the feature 
collected is not in the customized list, users can select 
‘Other’ for “Name” and enter proper description in the 
“Comments” entry. 
  
Note:  You can switch to the “Geography” page in the 
Points attribute form and enter coordinates of a known 
location rather than the location you tapped on the 
screen. 
 
For line or polygon features, you can switch to the 
“Geography” page in the attribute form to view their 
length and/or area values.  
 
Tap OK when finished entering data. 
 
 
 
 
 
 
Note that after a feature is added to a shapefile from the 
MasterProject folder, it is shown on the screen along with 
a label based on the ‘Name’ attribute entered. 
 
 
 
PRACTICE: Complete Activity #4a in Appendix K 
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Command toolbar 
For a feature with multiple vertices (e.g., polyline, polygon, etc.), a “Command toolbar” 
will be displayed at the bottom of the screen.  The toolbar along with each icon’s 
function is shown below. 

 
Note: The pen toggle can be selected (orange highlight) to enable data capture with 
GPS only when collecting line or polygon features. This prevents accidental capture of 
vertices when the stylus touches the screen.  Remember to remove that setting to 
digitize features without GPS. 
 
For a multi-vertex feature (e.g., polyline, polygon, etc.), select appropriate sketch tool 
from the Edit toolbar, tap on the desired location on your map to start digitizing, 
continue adding vertices until you are done with that feature.  To end the capture of that 
feature, tap the big right arrow icon  on the “Command toolbar” (explained above).  
This will bring up the form to collect the attribute data for that feature.  
 
 
Deleting features 
If you want to remove a feature, the shapefile that 
contains the feature to be deleted must be in the 
Edit mode.   
 
Then, on the Edit toolbar, tap the drop-down arrow 
on the second icon of the Edit tool bar and click on 
the ‘Select’ tool.   
 
Then, using the ‘Select’ tool click on the feature to 
be deleted. 
 
 
 
Click on the drop-down arrow of the ‘Feature 
Properties’ button and select ‘Delete Feature’ 
If the ‘Delete Feature’ option is not selectable, you 
may need to zoom in closer to the feature to be 
deleted in order to make sure it is selected with the 
‘Select’ tool. 
 
 
 
 
 
 

Save changes 

Save & proceed to 
attribute capture 

Undo 

Pen toggle 

Cancel 
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PRACTICE: Complete Activity #4b in Appendix K 

 

Device Settings for using GPS  
 
Before we capture geographic features with GPS, we need to discuss two important 
procedures:  1) setting the GPS Controller and 2) setting ArcPad preferences. The 
setup steps detailed here should only need to be done one time.  If the device has to be 
reset to factory defaults, the software has to be reinstalled, or the unit does not seem to 
be working as it should, you should check the setup again. 
 

GPS Controller 
 
The GPS Controller software allows users to configure the Geo7x unit to receive signals 
both from satellites and real time correction sources. The following steps are necessary 
to setup the GPS controller.   

 
1. Make sure the Geo7x in turned on 

 
2. Click GPS Controller on shortcut bar 

 
3. Click SkyPlot -> Setup  

 
4. Click on GNSS Settings 

 
5. Set GPS Receiver Port-> COM3 

 
6. IF AVAILABLE, Set Productivity/Precision scale bar to 50% (5th tic mark from left) 

 
7. IF AVAILABLE, add checkmark to “Use Smart Settings” checkbox 

 
8. Scroll down and set NMEA output -> ON 

 
9. Click on wrench icon next to NMEA  

 
10. Set Output interval -> 1s 

 
11. Checkmark sentences: GGA, GSA, GSV, RMC 

 
12. Click DONE to exit NMEA SETTINGS 

 
13. Click DONE ( to exit GNSS settings) 

 
14. Click Real Time Setting 
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15. Set CHOICE 1-> Integrated SBAS (Space Based Augmentation Service, e.g. 
WAAS)  
 

16. Set CHOICE 2->  Use Uncorrected GNSS 
 

17. Set Real Time Age limit -> 2 minutes 
 

18. Click on wrench icon 
 

19. Set tracking mode to auto 
 

20. Click DONE 
 

21. Click DONE to exit Real-time Settings 
 

22. Click Setup -> Exit  
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ArcPad Preferences 
 
ArcPad can be used to set user preferences for GIS functions. If ArcPad is not already 
open, you can start the software as follows: select Start > ArcPad 10.0 or tap the 

ArcPad icon  on the Home screen.  Click on ‘New Map’ option. 
 
To set up or check ArcPad options, tap the Options icon on the Main toolbar. 
 

 
 
There are a few option screens that really need to be checked, including “Display”, 
“Camera”, and “Paths”.  
 
The “Display” screen comes up first. Recommended settings 
are shown on the image on the right, “Display Units” should be 
set to Statute (US Units) 
 
 
 
 
 
 
 
 
 
 
To switch to “Camera” screen, tap on “Camera” tab near 
the bottom of screen. 
 
The “Camera” Application should be set to Windows 
Mobile Camera. 
 
The “Default Pictures Path” should be set to \Storage 
Card\DCIM\100IMAGE. Note that you may have to type in 
this path if the DCIM directory is not available through the 
Browse folder listing. 
 
The filename prefix is set to Photo by default.  This means 
that photos will be saved with a name starting with that 
prefix followed by a number, e.g. Photo_0001.jpg.  In 
practice, it is more useful to replace the default prefix with 
a customer tag (e.g. customer’s initials/last name or similar 
combination) to more easily identify the customer folder(s) on the workstation where 
such photos need to be transferred later on. 
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To switch to “Paths” screen, tap on “Paths” tab near the 
bottom of screen. 
 
The “Default Maps & Data Path” should be set to 
\Storage Card shown at right.  This can be done either by 
using on-screen keyboard or by tapping yellow folder icon 
to right of input field and then navigating to \Storage 
Card.   
 
The other values should be left as shown. 
 
Tap the ok icon  in lower left of screen. 
 
 
 
 
 
 
 
 
ArcPad Extensions 
To ensure MrSID images (e.g., orthoimagery) 
display, the MrSID extension needs to be turned 
on.  This should already be set.    
 
To verify this, tap the drop-down arrow under the 
Options icon on the Main toolbar and then select 
Advanced Settings on the menu.  
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Tap the right arrow at lower right of 
screen to scroll over to “Extensions” 
tab. 
 
Using vertical scroll bar, scroll down to 
“MrSID” and make sure the box is 
checked. 
 
If there are any other extensions you 
know that you need, you can check 
them as well. 
 
Tap the ok icon  in lower left of 
screen. 
 
 
 

 
 
 
GPS Preferences 
In order for the GPS receiver to work with 
ArcPad, the GPS preferences need to be set 
correctly.   
 
To set these, tap the drop-down arrow under the 
GPS icon on the Main toolbar and select “GPS 
Preferences” on the menu. 
 
 
The first 3 screens of GPS Preferences are 
shown below – GPS, Capture, and Quality. 
 

COM2: 
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The items that MUST be set as shown above are as follows: 
Geo7x : GPS – Protocol: NMEA 0183 ;  Port: COM2:  ; Baud:  4800 
 
The recommended settings of items shown above are as follows: 
GPS – Automatically Activate:  unchecked 
 Show GPS Activity in System Tray:  checked 
 Automatically Pan View:  checked 
 Log:  unchecked 
Capture – Enable Averaging – may be left unchecked.  For greater precision, add a 
checkmark and set the number of positions to average points for vertices as 
recommended later in the Position Standards section.  Note: The distance interval 
should be set to a smaller value (e.g. 3m) when capturing vertices at intervals smaller 
than 10 meters 
 
Quality – Non-compulsory Warnings selected.  This setting will provide a warning when 
trying to record a GPS measurement that does not meet the criteria set on this screen.  
You will still be able to store the point by responding Yes to the prompt given. 
Check and set the other values as shown:  Max PDOP=5, DGPS Only, 3D Mode Only. 
 
The remaining items are “user preference” (i.e., set as you desire).  The other 2 screens 
of preferences you should check are “Datum” and “Alerts” (see below).  To move to 
these screens, tap the right arrow button  to the right of the tabs on the bottom of the 
screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Datum – GPS Datum should be set to D_WGS_1984. 
Alerts – The items on this screen can be set as you desire.  These alerts can be quite 
annoying, so you might want to turn most of them off as shown above.  A check in the 
first column will cause a message to display on the screen when that alert condition 
occurs (e.g. Maximum PDOP exceeded).  A check in the second box will cause a sound 
to play when the condition occurs. 
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Tap the ok icon  in lower left of screen.  
 
To exit ArcPad, Tap  ArcPad’s “quick action” 
icon and select “Exit”. 
 
 
 
 
 
 
 
 
 
 
 
 
PRACTICE: Complete Activity #5 in Appendix K 
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Data Capture Standards  
GPS collection standards are needed to ensure consistency in the method of collection, 
data quality, and the accuracy and repeatability of measurements. 

Position Quality Indicators 
Several parameters are used to gauge the quality of position (QOP) provided by the 
Trimble Geo7x.  These parameters include: 
 

1. GPS Status:  method of computing horizontal positions based on 3 
satellites (2D), or both horizontal and vertical positions based on 4 
or more satellites (3D).   
  

2. Positioning Mode: positions are computed using satellites signals 
alone (GPS) or augmented by ground or air-based sources of 
differential corrections (Differential GPS) 
 

3. Position Dilution of Precision: numeric value representing 
satellite geometry, i.e. the positioning of satellites relative to each 
other and to user.  GPS receiver computes accurate positions when 
satellites are well spaced and cover a large portion of the sky. 
 

4. Strength of Satellites: shown as bar chart of relative signal 
strength of satellites in the almanac 
 

5. Number of Satellites in Solution: number of satellites being used 
to calculate positions 
 

6. Differential Data Age: Age, in seconds, of the differential signal 
and correction used by the GPS receiver to correct GPS position 
 

7. Horizontal Accuracy: Estimated accuracy of the current GPS 
position, in meters 

 
Parameters 1- 3 are displayed on the ‘Data’ tab in ArcPad’s GPS Position window. To 
access the GPS Position window, tap the drop-down arrow under the GPS icon on the 
Main toolbar and select the first option on the menu.  Parameter 4 is on the Skyplot tab 

Skyplot Tab:  Parameter 4  Data Tab: Parameters 1 - 3 
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Parameters 5-6 are located on the Quality Tab.  More information about the GPS 
Position window is available in Appendix E. Parameter 7 is displayed in the GPS 
Controller’s Skyplot Status Bar above the satellite icon. 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Positioning Standards 
 
Guidelines for Positioning Requirements and Standards are listed in the following 
documents:  GM 170 Part 400 Subpart D (35). The table below shows current 
positioning standards for resource inventory and practice certification tasks.   

 
QUALITY OF POSITION INDICATORS RESOURCE        

INVENTORY 
 PRACTICE 

CERTIFICATION 

GPS STATUS 3D 3D 

POSITIONING MODE DIFFERENTIAL  GPS DIFFERENTIAL GPS 

POSITION DILUTION OF PRECISION 5 or less 3 or less 
SIGNAL STRENGTH OF EACH SATELLITE 50% or more 50% or more 

NUMBER OF SATELLITES IN SOLUTION 6 or more 7 or more 

DIFFERENTIAL DATA AGE (Maximum) 120 seconds 60 seconds 
HORIZONTAL ACCURACY 10 meters or less 6.1 meters or less 
 

The first positioning meeting all criteria is acceptable for use in the capture of 
geographic features.  In practice, those parameters may fluctuate as users move in and 
out of challenging environments, e.g. under tree canopy, in areas where augmentation 
is lost, or satellite geometry declines).   When operating in challenging environment, 
users should follow these guidelines: 
 

GPS Controller-Skyplot: Parameter 7  

Quality Tab:  Parameters 5 - 6 
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1) GPS positions should be averaged for 15 seconds when any two 
of the following situations occur:  

a. Number of satellites in solution is less than standard, but not 
less than 5 

b. Signal strength is less than standard, but the majority of 
satellite signals is greater than 50% 

c. PDOP is greater than standard, but not greater than 6 
d. Canopy closure is between 10 to 40% 
e. Terrain masking is between 10 and 30o  

 
2)  GPS positions should be averaged for 30 seconds when any 

three of the following situations occur:  
a. Number of satellites in solution is less than standard, but not 

less than 5 
b. Signal strength is less than standard, but the majority of 

satellite signals is greater than 50% 
c. PDOP is greater than standard, but not greater than 6 
d. Canopy closure is between 10 to 40% 
e. Terrain masking is between 10 and 30o   

 
3) GPS positions should be averaged for 60 seconds when any four  

of the following situations occur:  
a. Number of satellites in solution is less than standard, but not 

less than 5 
b. Signal strength is less than standard, but the majority of 

satellite signals is greater than 50% 
c. PDOP is greater than standard, but not greater than 6 
d. Canopy closure is between 70 to 100% 
e. Terrain masking is greater than 45o  

 
4) Beyond those considerations and under ‘No Fix” conditions, users 

should consider using a “hybrid “ collection techniques such as: 
 

a. Using Trimble Geo7x, locate position where QOP indicators 
are within acceptable levels, capture endpoint, measure 
direction and distance from that point to end of segment to 
be measured.  Direction is displayed as TCOG [True course 
over ground] in Data tab of ArcPad GPS window.  Distance 
can be measured with a tape.  Likewise, using a calibrated 
laser range finder is an acceptable practice. 
 

b. Using High Accuracy GPS in open areas to set an accurate 
point and traditional survey techniques to tie the point to the 
data collection site.  

 
When “hybrid” data collection techniques are used, the estimated accuracy for 

the GPS position and the traditional technique should be noted in the features 
attributes 

 
 
 

Limitations on Measurements 
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As per GM170 Part 400 Subpart D (35)(C)  GPS technology should not be used for 
NRCS measurement applications when: 

1) PDOP is greater than 6.0 
2) Number of satellites in Solution is less than 5 
3) Signal strength of the majority of the satellites is less than 50% 
4) No differential corrections are available (i.e. GPS unit is not 

operating in DGPS mode) 
If a management practice is applied to the entire extent of a planning unit (e.g. 
prescribed grazing on a 40-acre field already delineated on an FSA map), then the 
extent of that practice does not need to be delineated with GPS.  If a management 
practice is applied to an area easily identified on an orthophotograh (e.g. prescribed 
burning in a wooded lot clearly visible on an orthomosaic image), then the extent of that 
practice does not need to be delineated with GPS. 
In addition, the following restrictions are in place until additional field testing is 
completed 

 Area Measurements 

GPS can be used for measuring any area for practice certification.  Strict 
adherence to quality of position standards is recommended for areas less than 2 
acres. 

Length Measurements 
GPS can be used to measure lengths greater than 500 feet for practice 
certification. For lengths less than 500 feet, an alternate method of measurement 
(i.e. 300 ft chain, measuring wheel, etc) shall be used in order to ensure that the 
measurement will meet current NRCS certification tolerances.  When Survey 
Grade GPS systems are used, there is no limitation on measurement of lengths.  

 
PRACTICE: Complete Activity #6 in Appendix K 
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Working with ArcPad – Part II  
 
If needed, launch ArcPad on the Geo7x either using an existing map document (*.apm) 
in the customer folder, or opening a new document and centering the view on the area 
of interest (e.g. PLU).  For better screen refresh rates, you may want to turn off the 
imagery, especially when using countywide orthoimagery. 
 

Initiating GPS data collection 
In order to record a feature at your current GPS location, you first need to activate GPS. 
Do this by tapping the “GPS Active” icon on the Main toolbar. 

 
The “GPS Active” icon should be displayed in an orange square to show it has been 
activated.  A red circular marker will be displayed in the map view area showing your 
current GPS location with a pointer showing the direction you are moving.  A translucent 
GPS status bar will show at the bottom of the screen. See the two examples in the 
screenshots below. 

 
The GPS status bar contains information as detailed in the images below.  The 
background color of the GPS status bar is used to indicate the current condition of the 
GPS measurements as stated below. 

GPS 
status bar 
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Adding features using GPS 
 
Once the GPS has been activated and you are receiving quality GPS measurements 
(patience may be needed!), you can begin adding features.  As instructed in the section, 
“Adding features without GPS”, you should first ensure that the proper shapefile(s) is 
(are) in the ‘Edit’ mode.  Then, use the Sketch tool on the Edit toolbar to select the 
feature type (e.g., point, polyline, polygon, etc.) you will be adding.  The left image 
below shows the Sketch tool when in “point” collection mode, while the right image 
shows the Sketch tool in “polyline” collection mode. 

 
 
 
 
 
 

 
Notice the 3 GPS icons in the toolbars above.  When in “point” collection mode, the first 
icon (“Capture point”) is the only one active.  When in polyline or polygon mode, all 3 
may be active.  Each of these icons uses the current GPS position in the following way: 
 

 :  Captures a point. 
 :  Captures a single vertex in the current line or polygon feature 
 : Continuously captures vertices in the current line or polygon feature 

 (determined by Capture settings in GPS Preferences). 

Current  
GPS coordinate 

Elevation 

Speed 

Satellites used of  
those available 

Skyplot 

Signal strength 

Quality 

Navigation 
Info 

Green background  
= Good quality fix 

Yellow background  
= Quality parameters 

not met 

Red background  
= No Fix 

(position not obtained) 

Point Polyline GPS GPS 
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Point 
To capture a point, your screen might look 
similar to that shown at right.  You are in point 
edit mode (pencil and point icons highlighted), 
you are at desired location, and GPS status bar 
is green with good quality info shown. 
 
Tap the “GPS Capture Point” icon. 
 
You will then be presented with the form to 
enter attribute data for that point. 
 
Enter the appropriate data and tap OK. 
 
Repeat this process to collect additional points. 
 
 
 
Polyline 
To capture a polyline, your screen might look 
similar to that shown at right.  You are in 
polyline edit mode (pencil and polyline icons 
highlighted), you are at desired location, and 
GPS status bar is green with good quality info 
shown. 
 
Tap the “GPS Capture Vertex” icon. 
Move to next location and tap the icon again. 
Keep doing this until you are finished with the 
line. 
Tap the right green arrow  on the 
command bar at the bottom of screen to end 
and save the feature. 
 
You will then be presented with the form to 
enter attribute data for that line. 
 
Enter the appropriate data and tap  OK. 
 
Polygon 
The procedure for capturing a polygon is the same as that above for a polyline with the 
exception that the feature type selected is “polygon” so the toolbar looks like that shown 
here. 
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Continuous 
You can capture polyline or polygon vertices 
continuously by using the third GPS capture 
icon as shown at right.  The procedure is similar 
to that above for polylines and polygons except 
that vertices are automatically recorded rather 
than you having to manually tap the capture 
icon at each location.  The recorded locations 
are based on the “Streaming - Position and 
Distance Interval” settings on the Capture page 
of GPS Preferences in section “Device Settings 
for using GPS”. 
 
The “Position Interval” setting is the number of 
readings received from the GPS receiver.  Since 
the Geo7x is set to take GPS readings every 
second, this number correlates to number of 
seconds.  
 
 
The “Distance Interval” setting is the distance 
you must move before the next vertex is recorded.  This is entered in the units of the 
current projection (which will most likely be meters if using the default UTM83 
projection). 
 
Both of these conditions must be met before the vertex is recorded.  For example, if the 
position setting is 10 and the distance setting is 30 meters, ten seconds must have 
elapsed AND you have moved at least 30 meters before GPS unit will capture the next 
vertex. 
 
To start continuous positioning capture, tap the icon and move.  When you arrive at the 
last point of the feature (polyline) or next to the starting point (polygon), tap the icon 
again to stop continuous mode.   
 
Once you are finished with the polyline or polygon, Tap the right green arrow  on the 
command bar at the bottom of screen to end and save the feature. 
 
You will then be presented with the form to enter attribute data for that line or polygon. 
 
Enter the appropriate data and tap  OK. 
 
Note that while in continuous mode, you can temporarily stop the continuous mode by 
tapping the icon.  You can then continue to manually add vertices to the polyline or 
polygon by using the “GPS Capture Vertex”. You can also move off the trail to capture 
nearby point feature(s) with the “GPS Capture Point” icon.  To resume data collection in 
continuous mode, just tap the appropriate icon when at the next position along trail. 
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If you are finished collecting GPS data and no longer need the GPS, you can deactivate 
the GPS by tapping the GPS icon  on the Main toolbar. 
 
ArcPad offers more complex tools for capturing and editing data with GPS.  For more 
information about the Offset and Editing tools, see Appendix F.  Likewise, ArcPad has 
tools to identify, measure and navigate to features listed in Appendix G.  A set of field 
guide index cards is available in Appendix H.  Troubleshooting topics are discussed in 
Appendix I.  
 
PRACTICE: Complete Activity #7 in Appendix K 
 

Using embedded camera 
 
The Geo7x comes equipped with a 5MP camera. There are two applications available 
for taking pictures:  one is included in Windows Mobile and the other in ArcPad.  
However, this manual will focus on using the Windows Mobile application because it 
offers more flexibility to users, and is also be available through ArcPad.  Let’s jump to 
Appendix A for an in-depth look at recommended procedures.   
 
 
PRACTICE: Complete Activity #8a in Appendix K 

 
 

Preparing for Practice Certification  
 
Make sure the Geo7x unit is fully charged before leaving the office. If a vehicle charger 
is available, use it to recharge the battery between sites. 
 
Before starting practice certification, wait until all the QOP indicators are settled within 
acceptable range and record their initial values on paper or in an electronic file.  These 
parameters should be included in a text box on maps of certified practices. 
 
If using a county orthomosaic and screen refresh is slow, you may want to turn off the 
imagery and turn it back on for double checking your position as needed.  For very large 
areas, it may be worth exporting a smaller subset of the county image to facilitate 
screen refresh rates, as explained in ‘Exporting Customer’s field boundary with 
ArcPad Data Manager’ section above. 
. 
 
PRACTICE: Complete Activity #8b in Appendix K 
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Importing GPS Data into GIS 

Downloading 
Once you have collected your data, you are ready to return to the office and download 
the data.  Downloading is actually just a matter of copying folders and files from the 
device using Windows Mobile Device Center software.  The details of connecting your 
device and copying files were given earlier in the section “Overview of Windows Mobile 
Device Center”. You should refer to that section for detailed steps.  A summary of those 
steps is as follows: 
 

1. Turn on computer and log-in. 
 

2. Connect device to computer using USB cable. 
 

3. Turn on handheld device. 
 

4. Windows Mobile Device Center will activate.  Click [“Connect 
without setting up your device].  The device will connect as a 
“guest”.     
 

5. On the WMDC window, select “File Management” on the menu. A 
Windows Explorer session will launch. Navigate to the root level of 
the SD card 
 

6. Open another Explorer Window on your workstation and copy the 
MasterProject<utm_zone> folder from SDCard to your 
workstation’s  C:\Users\<first name.last name>\GPS_data folder.  
If you have made any changes to the PLU delineation on the 
Geo7x, you need to also copy the customer’s folder back to the 
same target directory on your workstation 
 

7. If you have captured any photos or videos documenting certified 
practices, use Windows Explorer to navigate to the SD Card folder 
where such files are stored:  \Trimble Geo 7X handheld\Storage 
Card\DCIM\100IMAGE. Copy and paste those files to the customer 
folder where images will be transferred.  Such folders are located 
either in C:\Users\<first name.last name>\ GPS_DATA folder (if 
Toolkit is not available) or under C:\Users\<first name.last name>\ 
My Customer Files Toolkit.  See Appendix A for more details. 

 

Using the Data  
Once your data has been copied to your computer, it can now be used in any software 
that can utilize an ESRI shapefile. Below are some instructions on importing GPS data.  
Instructions for importing shapefiles into AutoCAD are provided in Appendix J.  For 
more complete help in using shapefiles in each of these programs, you should refer to 
their respective Help resources. 
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Incorporating features from Geo7x into ArcGIS 
 
Open an ArcMap document, then if the 
property boundary is not already in view, load 
that shapefile from the customer folder (i.e. 
Datafor<customer_name):   
 

1. Click the “Add Data” icon on the toolbar 
to select the property boundary layer.   

2. Use Zoom options to bring that layer 
into the center of the Data View, 

 
It Toolkit is available, open any 
ArcMap document in the customer 
folder and the data frame will be 
centered on the Case PLU.  Then 
load the shapefiles from the 
MasterProject<utm_zone> folder 
where you have collected GPS data 
(i.e., points.shp, lines.shp, or 
polygons.shp): 
 
On the ArcGIS button bar, click  ‘Add 
Data’. Navigate to the 
MasterProject<utm_zone> folder.    
 
Select appropriate shapefile(s) and 
click [Add ].  
 
 
 
The shapefile(s) will be added to 
your table of contents and be 
available to use in whatever way 
you desire.  
 
At this point, you should extract 
features from the larger datasets 
(.i.e. shapefiles from 
MasterProject<utm_zone>) into 
customer specific layers that you 
can store within a customer 
folder and share those files with 
another user. 
 
First, make sure each source 
layer (i.e., points.shp, lines.shp, 
or polygons.shp) is the only 
selectable layer in Table of 
Contents by clicking the 
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‘Selection’ tab and ensuring that the source 
layer is the only one listed in the ‘Selectable’ 
category.   
 
Select the desired features using standard 
selection tools and techniques (e.g., using the 
‘Select Feature(s)’ tool, click on individual 
features or draw a window around a group of 
features; using Query tools, select feature(s) 
based on attributes, etc.).   
 
Once features are selected, right-click 
on the layer in the table of contents 
on the left, select “Data -> Export 
Data”.  
 
Choose “Selected features” for Export.  Select coordinate system to match 
the layers’ source data and specify the customer folder (either in 
C:\Users\<first name.last name>\ GPS_DATA\Datafor<customer_name> 
folder (if Toolkit is not available) or under C:\Users\<first name.last name>\ 
My Customer Files Toolkit\<customer_folder>\Resource_Maps) where the 

shapefile will be stored.   
 
It is recommended to use the following 
convention for naming exported 
features: customer name_<feature 
type>_cert.shp, where feature type can 
be p for points, l for lines; and a for 
polygons.  Click OK.   
 
 
 
Example of ArcGIS shapefiles with GPS data 

 
 
 
PRACTICE: Complete Activity #9a in Appendix K  
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Updating Attributes and Labels 
 
Next, you will need to calculate length and area of certified practices features in those 
line and polygon shapefiles you’ve just exported.  To do so, open the attribute table of 
each respective shapefile (i.e., customer name_<feature type>_cert.shp) and use the 
‘Calculate Geometry’ function for the LENGTH or AREA fields, as shown below.  The 
calculated values represent certified measurements from the Trimble Geo7x data and 
can be used as map labels.  

 
 

 

Right click on 'Area' or 'Length' field and select 'Calculate Geometry'. Then, set Property and Units to be 
calculated 

 
To create map labels from those 
measurements, open the ‘Layer 
Properties’ dialog box of a shapefile 
(double click on layer name in Table 
of Contents), click on the ‘Labels’  tab 
and select the field to use as label and 
other formatting parameters. Make 
sure the ‘Label features in this layer’ 
checkbox has a check mark. 
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You should also add the units of measurements as 
part of the label.  This can be done by clicking on 
the “Expression” button next to the Label field and 
appending the appropriate units of measurement 
within double quotes preceded by an ampersand 
(e.g.:  &  “ft.”).   
 
Click on OK to close the Label Expression dialog 
box. 
 
Click on Apply in the Layer Properties dialog box to 
check your labels.  You may further edit your map 
labels as needed and click on OK when done to 
close the Layer Properties dialog box. 
 
 
 
 
 
 
If Toolkit is available, the Map Labels tool can be used to create labels on the screen 
display along with units of measurements. 
 

 
 
Such labels can be further edited using the Properties dialog box of selected elements 
in ArcGIS. 
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Example of map labels for practice certification map 

Adding a Hyperlink for Pictures 
 
Once pictures are copied into a customer folder, you can create a hyperlink to display 
those pictures in ArcMap.  The first step is to display layer(s) with features that have 
been photographed in the data frame.  Then, use the Identify button to click on the 
feature to be linked with a photo.  In the Identify dialog box, right click on the attribute 
listed for that feature and select ‘Add Hyperlink’.  Navigate to the location where the 

pictures are stored to select hyperlink target.  Then the Hyperlink tool on the Tools 
toolbar can be used to view hyperlinked photo(s) by clicking on a desired feature.  
 

 
 
PRACTICE: Complete Activity #9b in Appendix K 
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Developing a Practice Certification Map 
 
After exporting the GPS data into individual shapefiles, choosing appropriate 
cartographic symbols to represent features, and developing map labels, you need to 
create a ‘Practice Certification’ map that shows location and extent of certified practices, 
using NRCS planning symbols whenever possible (see example at the end of this 
section).   
 
In general, a practice certification map should follow the same formatting guidelines as 
a conservation plan map (see Title 180-Part 600 Subpart C.31 of the National Planning 
Procedures Handbook).  The title should be listed as “Practice Certification Map”.  In 
addition, the name of the person who completed practice certification and date must be 
listed on the map.  If you’re using Toolkit, the ‘Map Products’ button is an excellent tool 
to produce such a map.  Otherwise, the layout view of ArcGIS offers several tools to 
create and arrange different cartographic elements. 
 
The initial values of QOP indicators recorded in the field should be included in a text 
box.  In Toolkit, the ‘legal description’ box in the ‘Map Products’ dialog box can be used 
to enter initial values of QOP indicators.  
 

  
 
Once the layout is created on the display, remember to remove the “Legal Description” 
expression from the QOP text box before printing your map 
 
Consider using the National NRCS Conservation Practice Symbol stylesheet to 
represent certified practices to the extent possible. If there are too many practices to be 
represented on a single map, consider developing a series of maps to represent 
different groups of practices. 
 
For additional assistance, please review software documentation or contact your State 
GIS Specialist 
 
PRACTICE: Complete Activity #10 in Appendix K 
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Appendix A – Using Camera/Video Application  
 
This appendix contains two sections that describe how to capture photos with 
Windows Mobile outside of GIS, and within ArcPad where photos are associated 
with a geospatial footprint. 
 

Using the Camera Application with Windows Mobile 
Press camera button in center of keypad to launch 
camera or video application. If that button has been 
programmed for a different task, click on START > 
Pictures & Videos > Camera.  
 
When the camera application is started, it is by 
default in ‘Still’ (photo) mode. 
 
 
Adjusting the camera settings:  
 
The following steps typically need to be done once. To 
access the camera settings:  
1. Start the camera application and then tap Menu. 

The available camera settings are displayed in a 
list.  
NOTE: The list of available settings varies 
depending on whether you are in Video mode or 
Still mode.  You will tap the required setting to 
change the current value as indicated in the next 
steps.  

2. Set Date Stamp to ‘ON’, and Location to 
‘WaterMark’. 

3. You may want to set the Resolution to a setting 
lower than 5MP (e.g. 2MP or 3.2MP) if there’s a 
concern about size of images. 
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4. Click on ‘Options’, you will be presented with a set 

of additional options for storage location, file 
naming, location format etc.   
 

5. Set the ‘Save files to’ option to Storage Card.  Your 
pictures and videos will be stored in the following 
directory:  \Trimble Geo 7X handheld\Storage 
Card\DCIM\100IMAGE. This setting will facilitate 
transfer of images and videos from the storage 
card to specific customer folders on your 
workstation, as explained at the end of this 
appendix 

 
6. Other options can also be set according to user 

preferences (e.g. position stamp format, filename 
prefix etc.) 

 
7. Click OK to exit ‘Options’ menu 

 
  

 
To capture a photo: 
 
1. Press the Camera button on the keypad 

 
2. Hold the handheld steady. Use the preview 

window to frame the subject in the center of 
the frame. 

 
3. To focus, tap the preview window. A white 

box appears, which then turns green. If you 
do not tap the preview window, the camera 
assumes that the distant focus (that is, 
targets > 1m or so away) is OK, and it does 
not autofocus. 

 
4. To capture the photo, press and release the 

Camera button.  If you have set the camera 
to add a location stamp to your pictures, you 
need to wait until the lat/long values are 
displayed in the bottom right corner of the preview screen before 
capturing photo. 
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To capture a video:  
 
1. Tap the Menu button and then select Video.  
2. Use the preview window to frame the start of 

the video 
3. To start recording, press and release the 

Camera button. Move the handheld to record 
the video. 

4. To pause recording, tap Pause. 
5. To stop recording, tap Stop or press the 

Camera button. 
 
When the camera application displays, it is 
storing the photo or video file. Removing the 
battery or the memory card while recording may 
affect photos / videos or damage the memory 
card.  
 
To switch to ‘Still’ mode from Video mode, tap Menu and then select ‘Still’.  
  

Using the Camera Application with ArcPad 
 

ArcPad allows users to take pictures as standalone photos or as photos linked to 
geographic features. In order to maintain consistency in the storage and 
management of picture files, this section will focus on the process of capturing 
standalone photos with the QuickCapture toolbar.  This process creates a photo 
layer in ArcPad (on the Geo7x) with points indicating location of photos on the 
landscape.  When transferred to a workstation, those same photos can be 
hyperlinked to features included in resource inventory or practice certification 
datasets in ArcGIS. 
   
Adjusting the camera settings:  
 
Camera settings in ArcPad should be set according 
to instructions presented in the Device Settings for 
using GPS section. The image on the right shows 
the basic settings as a reminder. 
   
Remember that the filename prefix is set to Photo 
by default.  This means that photos will be stored on 
the SD Card with a name starting with that prefix 
followed by a number, e.g. Photo_0001.jpg.  In 
practice, it is more useful to replace the default 
prefix with a customer tag (e.g. customer’s 
initials/last name or similar combination) to more 
easily identify the customer folder(s) on the 
workstation where such photos need to be 
transferred later on. 
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To capture a standalone photo:  
 
1. Launch ArcPad and open a new or existing map 

 
2. Click on the QuickCapture toolbar 

 
3. If you want to capture a photo at current GPS 

location, click on the dropdown arrow and select 
the Camera tool. 

 
4. Once target comes into view follow instructions in 

the Using the Camera Application with 
Windows Mobile to take a photo. 

 
5. ArcPad will place a camera symbol on the 

screen indicating location of picture.  That symbol 
can be used to view information 
about the photo with the ‘Identify’ tool  

 
 
or to view the actual photo by selecting 
the ‘Hyperlink’ tool (available on the 
drop-down menu for the ‘Identify’ tool) 
and clicking on  a camera symbol 

 
6. The ‘Photo Point’ option allows users to tap the 

map location representing the photo on the Geo7x 
screen and launch the camera tool.  This option 
may be useful for resource inventory activities when GPS signals 
are not available or access to a location is restricted and an 
orthomosaic allows planners to identify the location of a feature 
on screen. 

 
To transfer pictures and videos:  
 
1. Connect the Geo7x to your workstation 

 
2. Open a Windows Explorer session on your workstation and 

navigate to the storage location of pictures and videos on your 
handheld device. 
 

3. Open another Windows Explorer session and navigate to the 
customer folder where images will be transferred.  Such folders 
are located either in C:\Users\<first name.last name>\ 
GPS_DATA folder (if Toolkit is not available) or under 
C:\Users\<first name.last name>\ My Customer Files Toolkit.  The 
Resource_Maps subdirectory in Toolkit can be used for that 
purpose.  See diagram on the following page. 
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4. A Photo viewer or Media Player application may also be used to 

view/verify content of images before transfer to workstation. 
 

5. Copy and Paste selected photos from the handheld to your 
workstation.   

 
6. Be sure to delete photos that are no longer necessary to maintain 

on either device. 
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Appendix B – Table of Contents 

Viewing Data 
The various layers in your map can be controlled (as described below) by tapping on 
the “Table of Contents” icon on the Main toolbar. 
 
 
 
 
Layers 
On the Layers tab, you can then check or 
uncheck the boxes under the appropriate 
columns for each layer.  
The columns are as follows: 

 -  visibility of layer (checked=visible) 
 -  enable identify tool (checked=on) 
 -  edit mode (checked=on) 

Note: You can only select one of each 
feature type for editing. 

 
The functions of the side toolbar are 
shown at right.  The bottom four icons 
are layer specific and require you to 
select a layer before the icon is active. 
 
 
Layer Properties 
 
Upon picking a layer and 
tapping the “Layer 

Properties” icon  , you will 
be presented with a screen 
with several tabbed pages. 
 
 
You can change the name of 
the layer and enter comments 
on the “Information” page.  
This does not change the 
shapefile name. 
 
 
The “Labels” page allows you to change how the feature 
is labeled. 
 
The “Symbology” page is used to change the symbol(s), 
control visibility, and edit the label. 

Select projection 
Map properties 
Add layer 
Layer properties 
Move layer  
   up or down 
   in display order 
Remove layer 
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To change the symbol, simply tap on the symbol you wish to change. 
 
 
A screen with three different pages will then display. 
A pre-defined style can be selected from the “Styles” page.  If you want to specify your 
own custom style, use the “Point Style”, “Line Style”, or “Polygon Style” page depending 
on the type of symbol you are changing.   
 
If the options are grayed-out, 
you will need to tap on the 
“Set to Default Style” button 
and then you should be able 
to change the settings. 
 
The “Scale” page allows you 
to change at what scales the 
symbol displays. 
 
Tap OK when done with 
your changes. 
 
 
 
 
 
 
 
 
Use the “Scale” page to set visibilities at different scales.  The “Hyperlink” page is used 
to specify a field to be a hyperlink field.  The “Attribute” page is basically for viewing the 
attributes of the layer and to manage indexes. 
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The “Transparency” page can 
be used to specify a particular 
color as being transparent. 
 
The “Geography” page simply 
provides information for the 
chosen layer.  It provides the 
total number of features in the 
layer as well as the layer 
extents.  Nothing is editable on 
this page. 
 
Tap OK when finished. 
 
 
Legend and Snapping 

 
The Legend tab allows you to change visibility (using 
check boxes) and also the symbology (e.g., style and 
color) of a feature.  Tap on the symbol to change style 
or color of that symbol. 
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The Snapping tab allows you to turn on/off snapping to 
a particular location (vertex, edge, end) on a feature 
and set the snapping tolerance. 
 
Tap OK to close window. 
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Appendix C – Projections in ArcPad 
 

Projections 
 
The first thing you need to be aware of when starting a new map is the projection you 
wish to work in (e.g. UTM NAD 83-Zone 16N-meters or UTM NAD 83-Zone 17N-
meters).  ArcPad, unlike ArcMap, can only use one projection for a map.  This means 
that any layer you create or add needs to be in the same projection to be used in the 
same map.  If a projection file named arcpad.prj exists in the \My Documents\My 
ArcPad folder, ArcPad will use it as the projection for the new map.  If a different 
projection is needed for a NEW map, you can add a layer (e.g., orthoimagery, shapefile, 
etc.) that has an associated projection.  This will set the current projection to that of the 
added layer.  An alternative method is to perform the following steps.  These steps 
should not be done if a map has been created and layers have already been added. 
 
 
1.  The first thing to do is check what the 

current projection is.  Do this by tapping 
the “Table of Contents” icon on the Main 
toolbar. 

 
2.  On the “Table of Contents” screen, tap the 

“Map Properties” icon on the toolbar on 
right side of screen. 
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3.  Use the right arrow button near the lower right 

corner of screen to scroll to the right and select 
the “Projection” tab.  This will show the 
information for the current projection selected. 
 
 
 
Tap ok to return to the “Table of Contents” 
screen. 

 
 
 
 
 
 
 
 
4.  Trimble Geo7x units in Florida have been updated 

with projection files (arcpad.prj) set to the appropriate 
UTM Zone where Service Centers are located. If you 
need to change the projection, tap the top icon 
(“Select Projection”) on the toolbar at right side of 
screen. 

 
 
 
 
 
 
5.  Select the folder where you have a projection file (i.e.,  .prj) 

that defines the desired projection you wish to use.  The 
example to the right shows a couple that were made and 
stored in the “My ArcPad” folder.   
Select the desired file. 
 
You can repeat steps 2 and 3 above to check that it did in 
fact change the current projection. 

 
 
 
 
 
 
6.  Tap ok to close the “Table of Contents” window. 
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Appendix D – Creating Shapefiles in ArcPad 
 

Preparing a Shapefile 
 
The first step we need to do is to create or add a shapefile to store our data.  There are 
several different options to accomplish this: 
 

- create shapefile in ArcCatalog/ArcMap or AutoCAD and copy to device 
- create shapefile on the device (“on-the-spot”). 
-  use ArcPad’s “Quick Project” feature (this creates a folder with 3 different pre-

defined shapefiles- points, lines, and polygons) 
 
Some of these, but not all, are discussed in this document. 

 
Create a new shapefile on the device 

 
To create a new shapefile, tap the drop-down arrow 
below the open folder icon on the Main toolbar.   
 
Select New > Shapefile 
 
The new shapefile window will appear  
(see below). 

 
 
 
 
 
 

1 

2 

3 

4 
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1. Select the type of shapefile you are defining from the “Type” drop-down 

list.  Note:  All types store x,y coordinates.  
Types with an M on the end (e.g., PointM) will 
also store an “m-measure-value” (sort of a 
time stamp) and types with a Z on the end 
(e.g. PointZ) will store a z-value (elevation) 
and an m-measure-value. 

2. Tap the “ + “ icon at the bottom.   
3. For the “Field” window that appears, enter a 

name for the field (i.e., attribute), select the 
type of field, and enter length and precision if 
applicable.  Tap OK.  

4. You are returned to the “New Shapefile” 
window with the new field added to the list.  
Repeat steps 2 and 3 for each field you wish 
to add. 
 
NOTE:  Utilizing these fields to collect data 
about the recorded features is an added 
capability over what you were able to do 
with the Garmin equipment.  It is highly 
recommended that you take full advantage 
of this capability by setting up fields 
appropriate to the task that you are trying to 
complete.    
 
Here is a screen showing a sample list of 
fields created for a shapefile.   
 

 
 
 
 
 

5. When done adding fields, tap OK. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5 
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Enter a name for the shapefile.  Try to be as descriptive as possible.  Use existing 
naming convention, i.e. <theme>_<feature type>_<location>.  The location could 
be a tract or field number instead of the typical state and county FIPS codes. 

 
Select a Location and then select a Folder, e.g. DataFor<Customer_Name>. 
 
Type should be Shapefiles. 
 
Tap  Save. 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will be asked if you wish to create a 

Quickform.  This is a form that will be used to 
enter attribute data for the feature.  You will 
normally want to answer “Yes” here. 

 
After answering “Yes”, you will define the 

Quickform using the screens shown below. 

Use “Layout” tab to define form properties: caption, size, pages (if any), text and 
background.  You might find the symbology, attribute, and geography pages 
useful when viewing feature properties. 

Use “Fields” tab to specify which fields to display on form. 

DataforFredSmith 

planprax_p_T435 
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Use “Controls” tab to specify required fields, min-max values, list values, and 
tooltips. 

Tap OK when done. 
 
A message displays informing you the form was 

created.  
 
You are now ready to begin adding data to this shapefile. 
 
 
 

Use “Quick Project” feature 
 
The first step is to set the default path name to the folder where you wish to store 
the QuickProject, e.g. DataFor<Customer_Name> or Projects.  See notes under 
”ArcPad Preferences” section for details.  Otherwise, the new QuickProject folder 
will be stored under \My Documents, separate from other relevant customer files.  
To create a “quick project” from the “Open Map” window, tap the “quick project” 
icon (see left window below). Leave CodePage set at Unicode UTF-8. (middle 
window below) 
Tap OK. 
A folder will be created in your default data path.  It will be named ”QuickProject” 
followed by a unique date/time stamp.  The three pre-defined shapefiles (i.e., 
Points, Lines, and Polygons) will be created in that folder (see right window below) 
and opened for editing. 
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Appendix E – GPS Position Window 
 
A “GPS Position Window” can be displayed by either tapping the drop-down arrow 
under the GPS Active icon on the Main toolbar and selecting “GPS Position Window” or 
by tapping on the GPS status bar. 
 
The “GPS Position Window” is actually a collection of screens (i.e., tabbed pages): 
Data, Skyplot, Compass, Quality, and Debug.  These are explained below. 
 
Data tab: 

 
The coordinates of your current position 
are shown on this screen along with 
altitude (i.e., elevation), navigation 
information, GPS mode, and quality of 
measurement.   
 
 
The type of coordinates displayed can be 
changed by tapping on the coordinates 
and selecting the desired type from the 
list as shown at right. 
The units shown for elevation can also 
be changed by tapping the elevation 
and selecting from list shown at right. 
 
 
The navigation values shown are  
SOG: speed over ground 
TCOG: true north course over ground (can be set to MCOG-magnetic north COG) 
DST: distance from current location to destination 
BRG: bearing from current location to destination. 
 
See “Positioning Standards” section for 
specific details about these values. 
 

Skyplot tab: 
 
The skyplot view shows a bird’s-eye view 
of the position of each satellite according 
to the satellite almanac. The outer circle 
represents the horizon (north is up); the 
inner circle represents 45° above the 
horizon; and the center point represents 
what is directly overhead 
 

Position 
Coordinates 

Elevation 

Navigation 
Information 
Quality of 
Measurement 

Skyplot 

Signal strength 
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Each satellite is displayed with its PRN number and a unique color.  If the color is 
outlined in black, it is available and being used for calculating the GPS position.  
Satellites available but not used are simply colored.  Grey satellites are unavailable. 
 
The signal strength bar chart shows the relative signal strength for each satellite.  
An asterisk in the bar indicates it is being used for calculating the GPS position. 
 

Compass tab: 
 
The compass screen shows the 
same navigation information that 
was on the Data screen plus a 
visual compass.  The orange 
compass needle indicates the 
direction you are moving.  The 
red line indicates the direction to 
your destination if you have set 
one. 

 
 
Quality tab: 
 

This screen displays the values of various 
parameters that are useful in determining 
the quality of the GPS location you are 
receiving.  
 
See “Positioning Standards” section for 
specific details about these values. 

 
 
 
 
Debug tab: 
 

This screen simply shows data being received from 
the GPS receiver.  It probably is not a screen you 
would view too often.  It would most likely be used in 
troubleshooting problems you may be having.  

 
 
 

Tap OK to close the GPS Position Window.  
 
 
 
 
 
  

Should be 
 

DGPS 
< 5 

Direction you 
are moving 

(TCOG) 

Distance 
(DST) 

& 
Direction to 
destination 

(BRG) 

Speed 
(SOG) 
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Appendix F – Offset & Edit Tools 
 

Offset Tools 
 
The offset tools can be used to record a feature that is either in an inaccessible location 
or a location where you are unable to get a GPS signal.  In ArcPad, there are two types 
of offsets: simple and complex.  A simple offset is performed on a polyline or polygon 
and only uses a constant distance measurement and either left or right of the feature.  
Complex offsets can be used for point features and vertices of polylines and polygons. 
Complex offsets use a combination of distance, bearing, and inclination measurements. 
 
Simple Offset 
To do a simple offset of a 
polyline or polygon, first make 
sure desired layer is in edit 
mode as described earlier. 
 
Tap drop-down arrow under 
the “Offset” icon on the Edit 
toolbar and select  
“Offset Polyline/Polygon”. 
Select left or right and enter an 
offset distance (units will be 
those of current projection). 
 
 
A red box around the “Offset Polyline/Polygon” button indicates that it is active. 
 
You should follow instructions given above for capturing the 
polyline or polygon.  As you are defining it, you will notice a 
red line which is at the given offset from the feature you are 
capturing. 
 
Once you are done and tap the right green arrow  on the 
command bar at the bottom of screen, the red line will 
become the saved feature. 
 
You will then be asked for the attribute data for that feature. 
 
 
 
Complex Offsets 
For complex offsets, ArcPad supports 1 point offsets and 2 point offsets.  Instructions 
for performing a 1 point offset, which uses distance and bearing measurements 
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(distance-bearing) to determine the offset, will be given here.  For 2 point offset 
instructions, you should refer to ArcPad’s help resources. 
 
To do a 1 point offset of a point, first make sure point 
layer is in edit mode as described earlier. 
 
Tap drop-down arrow under the “Offset” icon on the Edit 
toolbar and select “Offset Point”. 
 
Tap drop-down arrow under the “Offset” icon on the Edit 
toolbar and select “Set Reference Point A”. 
 
A red box around the Offset Point and Set Reference 
Point A buttons indicates that they are active. 
 
To set point A, move to desired location and tap  
“GPS Capture Point” icon or tap on the map at desired 
location.  A red circle with an “A” will be placed on the 
map. 
 
 
Tap the Point feature icon (see below).  Tap the screen anywhere in the map area.  
The Point/Vertex dialog box opens on the Offset page.  Enter the appropriate 
information (e.g., bearing, horizontal distance, vertical distance).  Tap OK.  Enter any 
attribute data and tap OK.  A new point will appear as shown below 

 

Editing Data 
ArcPad provides some basic editing functions that can be performed on your data.  As 
mentioned earlier, this requires that editing be enabled for the desired shapefile.  This 
can be done using either the method given in the Error! Reference source not found. 
section (using Start/Stop Edit on the Edit toolbar) or the method given in the Viewing 
Data section of Appendix B (using the Table of Contents icon on Main toolbar).   
 

Tap 

New point 
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If the feature you need to edit is not in the map view area, you can use the tools on the 
“Browse” toolbar shown here to move the feature into view or to select it. 
 
 
 
 
 
Switch to the Edit toolbar.  From the drop-down list of the “Select” icon (second from 
left), choose the desired select tool.   
 
The “Select” and “Select at GPS Position” tools are used 
to change a feature’s attributes; insert and append 
vertices; and move, rotate, scale, resize, and delete 
features. 
 
The “Select and Vertex Editing” tool is used to move (by 
pen, GPS, or offsets) and delete a feature’s vertices. 
 
Tap on the desired feature to select it.  It will be highlighted with a color and with a 
dashed box around it.  If the “Select and Vertex Editing” tool was chosen, a blue box will 
be placed around each vertex as shown below.  To modify the entire feature or the 
feature’s attributes, tap the drop-down arrow below the Feature Properties icon  and 
select the desired action.  Selecting “Feature Properties” will allow you to edit the 
attributes as shown below.  This can be done on the form page or the “Attributes” page.  

 
To edit a single vertex, you can tap and drag one of the blue boxes to move it or 
tap and hold one of the blue boxes, which will open  
the menu shown at right.   
Use “Move To…”  to move the vertex to a keyed-in x,y location or 
to a specified offset.   
Use “Move To GPS” to move the vertex to the current GPS 
position (only available if GPS is active). 
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“Delete Vertex” will remove that single vertex. 
 
 
 
While in edit mode, the Command toolbar is available at the bottom of the screen.   
The function of each icon is shown below. 

Tips:  Undo will only undo 1 change.  If more are needed, you will need to use the 
cancel icon to undo everything.  If the X cancel icon is green, it indicates there are no 
changes to undo. 
 
When done editing the feature, simply tap the save changes icon (green checkmark). 
 
  

Save changes 
can’t undo 

                 Inactive 

Undo last action 

Pen toggle 

Cancel changes  
since last save 
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Appendix G – Identify, Navigate, Measure Tools 
 

Identify Tool 
 
The “Identify” tool can be used to view (not edit) 
information about a selected feature.  To activate 
this tool, tap on the identify icon on the “Browse” 
toolbar.  Remember to enable the “identify “ tool in the “Layers” tab of Table of contents 
for the layer containing feature of interest. 
 
You can now select a feature by tapping on the desired feature.  A screen should 
then be displayed with one or more pages of information depending on how the 
shapefile and quickform were created.  The possible pages are Page #, Attributes, 
Picture, Symbology, and Geography (coordinates, length, and area).  Samples of these 
(except Picture) are shown below. 
 

 

Points Polygons  
(similar for polylines) 
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The “Identify” tool can be used to display the length of existing line features and the 
perimeter and area of existing polygon features.  To do this, switch to the Browse 
toolbar and tap the drop-down arrow for the “Identify” menu (fourth icon) and select 
Identify (see below).  The icon on the toolbar will switch to the “identify” icon  .  Tap 
on the desired feature (line or polygon).  The properties window opens for that feature.  
Use the right arrow near the bottom to move to the Geography tab and select it.  The 
lower half of that window will display the appropriate length (perimeter) and area values.  
NOTE:  If only one vertex is shown for a line or polygon and the area is not shown for a 
polygon, try restarting ArcPad (i.e., exit and then start ArcPad again).  When you check 
again, the vertices and area should appear.  Tap ok or    to close the window. 

 

 

Setting a Destination 
ArcPad along with the GPS can be used to navigate to a desired location.   
There are multiple ways to set your destination.   
 
Tapping on Map 

 
On the Browse toolbar, tap the drop-
down arrow under the Identify icon and 
select “Go To”.   You can then tap 
anywhere on your map to set the 
destination.   
 
 
 
 

  

Select a feature 
(e.g., polygon) 
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Using Advanced Select 

On the Browse toolbar, tap the drop-down arrow under the Identify 
icon and select “Advanced Select”.   You can then select a single 
feature by tapping it or multiple features by dragging a window 
around them.  Highlight the desired feature in the “Feature 
Information” window and tap the Go To icon  . 

 
Using Find (binoculars) 

 
On the Browse toolbar, tap the Find (binoculars) icon.   
You can then find a feature based on a query of attributes (see step 1 below) 
or find a location by entering known coordinates (step 2 below). 
 
1. On the “Query” tab, specify desired search criteria.  Tap OK.  Highlight 

feature in “Results” screen.  Tap Go To icon . 
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2. On the “Location” tab, select coordinate system and then specify the 
desired coordinates.  Tap OK.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Select then Go To from Edit toolbar 
 
Use the Select tool on the Edit toolbar to select the desired feature 
on the map.  Once selected, tap the drop-down arrow under the 
Select icon and choose “Go To Selected Feature”  

 
Labeled Destination 
 

Once the destination has been determined, a 
point labeled either “Mark” or with the field the 
feature was searched on with the Find tool is 
placed on the map similar to that shown at right.   
 
For lines and polygons, this point will be the 
centroid of the selected feature. 
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Getting to the Destination 

If GPS is not activated, you need to do that using the GPS icon  on the Main toolbar.  
You then need to wait until you get a good GPS fix. 
 
 
 
To assist in navigating to your 
destination, you can then use the  
left side of the GPS Status bar 
(shown at right)  
 
 
 
 
 
or  
 
 
 
 
 
 
the Data or Compass tabs on the 
GPS Position window.  The useful 
information is highlighted on the  
screen images at right.  
 
 
If you are traveling in the correct 
direction, the TCOG and BRG 
values should be the same and the 
red direction line on the compass will 
be pointing to the top of the screen 
in line with the orange compass 
needle. 
 
 
When done navigating, you can 
clear the destination point by tapping 
the “clear selected features” icon on 
the Browse toolbar. 
 

Distance 
(DST) 

& 
Direction to 
destination 

(BRG) 

Direction you 
are moving 

(TCOG) 

Distance 
(DST) 

& 
Direction to 
destination 

(BRG) 

Speed 
(SOG) 

Speed (SOG) 
& 

Direction you 
are moving 

(TCOG) 

Navigational 
Information 
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Measuring 
If you have a need to measure distances or areas, you have four different methods to 
choose from: Measure, Radial Measure, Freehand Measure, and the Identify tool. 
 
Measure tool 
To use the measure tool, switch to the Browse toolbar and tap the drop-down arrow for 
the “Identify” menu (fourth icon) and select Measure (see below).  The icon on the 
toolbar will switch to the “measure” icon  .  Tap the first point where you wish to 
begin measuring from.  Continue tapping points along the line or around the area you 
are measuring.  When done, tap the “proceed” icon in the command toolbar at the 
bottom.  A measurement screen should appear with the appropriate information.  The 
From and To Locations are the coordinates of the first and last points (i.e., taps).  Direct 
Distance, From -> To angle, and To -> From angle are compass azimuth front and back 
bearings for the straight line direct distance between the first and the last point.  
Distance Along is the total length of the drawn line.  Closed Area assumes a line drawn 

from the first to last point to close the figure.  Tap OK to close window. 
 
Radial Measure tool 
To use the radial measure tool, switch to the Browse toolbar and tap the drop-down 
arrow for the “Identify” menu (fourth icon) and select Radial Measure (see below).  The 
icon on the toolbar will switch to the “radial measure” icon  .  Tap and Drag from 
the first point to the second point.  When you lift the stylus, a measurement screen 
should appear with the appropriate information.  The From and To Locations are the 
coordinates of the first and second points.  Radius, From -> To angle, and To -> From 
angle are from the first to the second point.  Perimeter is the perimeter distance for the 
circle of given radius.  Closed Area is the area for a circle of given radius.  Tap OK to 
close window. 
 
  

1 2 

3 and 
so on 
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Freehand Measure tool 
To use the freehand measure tool, switch to the Browse toolbar and tap the drop-down 
arrow for the “Identify” menu (fourth icon) and select Freehand Measure (see below).  
The icon on the toolbar will switch to the “freehand measure” icon  .  Tap and 
Drag the stylus on the map as you draw a “freehand” line.  Upon lifting the stylus, a 
measurement screen should appear with the appropriate information.  The From and To 
Locations are the coordinates of the first and last points.  Direct Distance, From -> To 
angle, and To -> From angle are from the first to the last point.  Distance Along is the 
total length of the drawn line.  Closed Area assumes a line drawn from the first to last 
point to close the figure.  Tap OK to close window. 

 
  

1 

2 
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Appendix H– Field Guides 
 
The “Field Guides” below are simply instruction “cards” that can be printed  
(single-sided), cut out, folded (where indicated), and laminated to carry along with the 
Geo7x GPS unit in the field. 
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Table of Contents & ArcPad Options 

 
  

ArcPad Options 
Recommended Settings 

1 

ArcPad Field Guides - Table of Contents 

 Page 
ArcPad Options/Recommended Settings ................................ 1 
GPS Preferences ................................................................. 2-3 
Create New Quick Project ....................................................... 4 
Create New Shapefile ............................................................. 5 
New shapefile (Add Fields) ..................................................... 6 
New shapefile (QuickForm) ..................................................... 7 
Collecting Data ..................................................................... 8-9 
Viewing Data .................................................................... 10-11 
Editing Data ........................................................................... 12 
Setting a destination .............................................................. 13 
Measuring ........................................................................ 14-15 
Troubleshooting ..................................................................... 16 
 

Fold 
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GPS Preferences 
 
 

 
 
  

GPS Preferences (page 2) 

If unit has trouble finding satellites, enter coordinates of current location on location tab 
(these do not have to be exact). 

3 

GPS Preferences (page 1) 

NOTE: Protocol, Port, and Baud must be set as shown above. 2 

COM2: 
4800 

Fold 
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Create New Quick Project / New Shapefile 

 
 
  

Define  
fields 

 
(See 

“Add Fields” 
card) 

On Main toolbar, 
Select  New -> Shapefile 
from Open Map menu. Enter name and desired 

storage location. 
Tap Save. 

Create New Shapefile 

Define  
QuickForm 

 
(See 

“QuickForm” 
card) 

5 

Create New Quick Project 

Tap quick project icon in 
Open Map window 

3 shapefiles will be created: 
     Points 
     Lines 
     Polygons 
 
in a Quick Project folder.  
 
 Note:  if you want to control 
where the QuickProject folder 
is stored, you need to set that 
parameter in the default 
Maps & Data Path under 
ArcPad Options prior to 
creating a new QuickProject. 

Tap OK 

4 

Fold 
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New Shapefile Setup 

 
 
  

1 

2 

3 

4 

5 1) Select type. 
2) Tap +. 
 
or use [Import…] 

3) Enter field info. 
    Tap OK. 

4) Repeat steps 2 and 3  
                  for each field. 
5) Tap OK. 
 

New shapefile (Add Fields) 

6 

Enter form layout info. Choose fields. 
Set additional properties: 

required, min, max,  
list values, tooltip 

New shapefile (QuickForm) 
Tap OK to save & exit. 

7 

Fold 
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Collecting Data 
 

 
  

Collecting Data (page 1) 

Occupy point 
Wait for quality GPS signal: 
  green status -  DGPS 3D, PDOP<5 

Put in point mode. 
Tap GPS Capture Point icon. 

Point 

Turn on edit of desired feature(s). 

Activate GPS. 

Polyline 
Polygon 

Put in polyline or polygon mode. 
Tap GPS Capture Vertex icon. 
Repeat for each vertex. 

When finished with line or 
polygon, tap “Proceed” icon 
on command toolbar. 

Complete attribute data. 
Tap OK and repeat  
          for next feature. 8 

Fold 

Collecting Data (page 2) 

Put in polyline or polygon mode. 
Tap GPS Continuous Capture icon. 
Travel desired path.  Tap icon to turn off. 
Tap “Proceed” icon to end capture. 

Continuous 

Set “Streaming” settings 
in GPS Preferences -> Capture Capture polyline or polygon 

as described on other card. 

When finished with line or 
polygon, tap “Proceed” icon 
on command toolbar. 

Complete attribute data. 
Tap OK and repeat  
                for next feature. 

Offset 

Select “Offset Polyline/Polygon”. 
Select side and enter distance. 

9 
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Viewing Data 

 
  

Viewing Data (Table of Contents) 

Set visibility, edit and 
identify modes and 

other properties. 

Change symbology. 
Can also be done via 
Layer Properties. 

Activate GPS. 

Set snapping criteria. 

11 

Viewing Data ( Identify ) 

View:      attributes point coordinates 
vertex coordinates and 
length and areas for 
polygons & polylines 

Then select a feature 

10 

Fold 
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Editing Data / Destinations 

 
  

Editing Data 

Choose appropriate 
Select tool on Edit toolbar. 

Select desired  
edit feature action 

or 
Tap and Hold  

on a vertex and select 
vertex edit action Select feature or 

Tap and Drag  
a vertex. 

Ensure feature is in “edit” mode. 

Save changes 
can’t undo 

Does nothing 

Undo last action Cancel changes 
since last save 

Pen toggle 

Command 
Toolbar 12 

Fold 

Setting a destination 
Tap on Map: 
Browse toolbar > Identify drop-down > 
Go To   tap on map 

Use compass on GPS Position window  
to navigate to destination. 

Advanced Select: 
Browse toolbar > Identify drop-down > 
Advanced Select > select feature(s) 
> highlight feature >  tap Go To icon . 

Find: 
Browse toolbar > binoculars icon > 
specify criteria > highlight feature in 
Results window >  tap Go To icon   
or 
Enter known coordinates (location). 

Edit Select: 
Edit toolbar > Select icon > 
select feature > Select drop-down > 
Go To Selected Feature. 

Getting to the destination 

Activate GPS. 

Distance 
(DST) 

& 
Direction 

to 
destination 

Direction you 
are moving 

(TCOG) 

13 
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Measuring 

 
  

Measuring (page 1) 

Select desired  
edit feature action 

or 
Tap and Hold  

on a vertex and select 
vertex edit action 

Tap points along  
line or around area. 
Tap “proceed” icon. 

Select drop-down for Identify 
menu  on “Browse” toolbar 
 
Select:  Measure, 
             Radial Measure, or 
             Freehand Measure. 

1 2 

3 and 
so on 

1 

2 

Measure Radial Measure 

Tap and Drag from  
first point to second point. 

Lift stylus. 

14 

Fold 

Measuring (page 2) 

Tap feature. 

Measurements info 
is displayed. 

Tap OK to exit. 

Freehand Measure Identify Tool 

Length and area given on 
“Geography” page. 

Tap cancel icon to exit. 
Tap and Drag  

to draw freehand line. 
Lift stylus. 

15 
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Troubleshooting 

 
 
  

Troubleshooting 
Unit Not Responding 
   Is device locked?  If so, unlock it (“Unlock” at bottom or lock icon in ArcPad),  or 
   Reset device -  hold down Power button, select “Reset”,   or 
   Remove battery.  Reinsert battery.  
 

16 

GPS very slow at obtaining fix 
   Wait longer, or  
   try entering approx. location on “Location” page of GPS Preferences  
GPS Off 
   Check settings in GPS Preferences (see other field guide). 

Zoom Extents / nothing displays 
   Either there is nothing to display, or features are extremely far apart. 
   Try “Zoom to Layer” or use Find tools to look for features. 

GPS location is incorrect or not stable 
   Check surroundings for possible obstructions. 
   Reset (i.e., reboot) device.  Hold down Power button, select “Reset”. 

Fold 
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Appendix I – Troubleshooting 
 
Unit is not responding (locked up) 
 

The first thing to check is if the device got “locked”. 

If in ArcPad, check the small lock symbol   in upper right corner.  If it is 
locked, tap it and select Yes to unlock.  If it is unlocked, something else is 
wrong. 
 
If not in ArcPad, check the bottom of the Today screen.  If it says “Unlock”, tap 
the word and then tap again on “Unlock” near the middle right of the screen.   
 
If the above actions don’t work, hold down the power button until a menu 
appears.  Tap on “Reset”.  This should cause the device to do a reboot.   
 
If this doesn’t work, it may be necessary to remove the battery temporarily and 
then reinsert the battery.  You should then be able to power it up. 

 
GPS very slow at obtaining a fix 
 

If the unit had last been used at a location far from where you are now or this is 
the first time you have had it out at your current location, it may take awhile for 
the GPS to “find itself”.  To speed this up, one thing you can try is to manually 
enter your location.  You can do this by going to “GPS Preferences” in ArcPad 
and entering the lat-long coordinates of your present position in the “Location” 
page.  This does not have to be real accurate, but just in the general vicinity. 

 
GPS Off 
 

This message indicates that ArcPad is not receiving any information from the 
GPS receiver.  Most likely the reason is that the settings on the “GPS” page 
under “GPS Preferences” in ArcPad are incorrect.  Check the Error! Reference 
source not found. section in the main body of this document for correct settings. 

 
I do a Zoom Full Extent and nothing seems to be there 
 

You may have features that are extremely far apart.  One thing you might try is to 
use the “Zoom to Layer” tool under the “Browse” menu.  You also can utilize find 
and select tools to diagnose if this is the case.  If you find an errant feature, you 
could then delete it using the edit instructions given above. 
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GPS location is incorrect or is not stable (i.e., constantly changing by 
a large amount) even though PDOP shows a good value.  

 
The first thing to check is that you are not near some object (e.g., chain link 
fence, metal sign, another electronic device, etc.) that may be affecting the GPS 
signals.   
 
If that is not the case, you should then reset the device.  Hold down power button 
until menu appears.  Tap  Reset.  The unit should reboot and the problem 
should (hopefully) be resolved.  
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Appendix J – Importing Shapefiles into AutoCAD 
 

Method I 
 
This method creates a “data connect” to the shapefile.  The features are 
not imported to drawing objects, but rather a connection is made where 
you can edit the shapefile directly. 
 
 
Open the “Task Pane” palette and select the 
“Display Manager” tab.   
Click on the “Data” icon in top toolbar.   
Select Connect to Data… 
 
In the Data Connection window (below), 
select  “Add SHP Connection” in left window. 
Enter a connection name. 
Click yellow folder and navigate to the folder 
where shapefile was saved and click [ OK ] 
Click [ Connect ]. 
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A list of shapefiles in the selected folder will be listed (see screen below).   
 

 
If the coordinate system is not set for the desired shapefile, click the  
“Edit Coordinate Systems” tab. 
Check the box to the left of the desired shapefile. 
Click [ Add to Map ]. 
 
You can then close the Data Connect window. 
The shapefile is now listed in the Task Pane’s Display Manager window. 
To learn more about how to use the data, refer to AutoCAD’s help.   
 
 

Method II 
 

This method imports shapefiles in a way that each of the points, lines or polygons 
becomes a drawing object.  If any change is made to the drawing objects, such change 
will not be reflected in the original shapefiles.  The modified drawing objects can be 
exported out as new shapefiles. 

 
1. Start a new drawing using the AutoCAD.dwt template 

 

2. Click on the Workspace  button on the status bar and set the current 
workspace to Planning and Analysis. 

 

 
 

3. Select Ribbon: Insert => Import => Map Import. 
 
The Import Location dialog box opens. 
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4. Browse to the dataset 
 

5. Set the Files of type to  ESRI Shapefile (*.shp) 
 

6. Select the files Parcels.shp and Streets.shp 
 

7. Click <<OK>> to continue. 
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Appendix K – Training Exercises 
 

Activity #1 
 

□ Name steps to find amount of memory available on device and SD 
card 
____________________________________________________ 
 
 ____________________________________________________ 
 
 

□ Using the Geo7x, open File Explorer and navigate to SD Storage 
Card 

o Open folder named ‘docs’ 
o Rename file oldname.txt  to activity1.txt (if those files are 

not visible, click on Menu, make sure the option to ‘Show all 
Files’ is checked) 

o Create a subfolder named ‘temp’ under docs 
o Copy ‘original.txt’ to temp folder 

 
□ Using NOTES file :   

o Click START > NOTES  
o Verify that the default folder name (upper left corner) is set to 

‘All Folders’ as shown below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o  
 

o Click “New  Note” icon “or press Left 
Application button 

o Use stylus to “hand” write your name 
o Use keyboard to type today’s date.  
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o FYI: The Notes file created will be 
named with the first alphanumeric 
characters entered with the 
keyboard.  If you did not use the 
keyboard, the operating system 
assigns a default name (e.g. NOTE1) 
to the new file created. 
 

o Click OK to close Notes file 
 

o Click button to exit Notes 
interface 

 
 
 

 
□  Using the Geo7x, open File Explorer and navigate to ‘\My 

Documents’  (i.e. My Device\My Documents)   
 

o Move (Cut & Paste) Notes file created in previous step to the 
docs\temp subfolder on the SD Storage Card 
 

o Rename Notes file created in previous step to Smith_QOP 
 

  
□ Using Office Mobile Applications: 

 
o Click START > Office Mobile 2010  

 
o Click on an application of your choice 

(e.g. Word Mobile 2010, Excel Mobile 
2010 etc.) 

 
o Click on New to open a new document 

 
 

o Click Menu > File > Save as.. to save 
this document under ‘DataForGPSTrain’ 
on the SD card with a name of your 
choosing 

 
 
 

□ Perform a soft reset on the Geo7x 
 
 
 
End of Activity #1  
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Activity #2a 
 

□ Create a ‘GPS_Data’ folder on your workstation under 
[C:\Users\<first name.last name>] 
 

□ Connect your Geo7x and workstation using a ’Guest’ connection  
 

□ Open new Explore session for Geo7x from Windows Mobile 
Device Center on workstation 
 

□ Open the SD Storage Card directory  
 

□ Use Drag & Drop to copy folder named DataForGpsTrain from the 
SD Storage Card to the GPS_Data folder previously created on 
your workstation  
 

End of Activity #2a 
 

_______________________ 

Activity #2b 
□ Open ArcMap Editor: 

o If Toolkit is available, open Toolkit Training Customer, 
launch Toolkit_Template.mxd 

o If Toolkit is not available, launch ArcMap (click  > 
All Programs > ArcGIS > ArcMap) 

 

□ Add the following layers located in DataForGpsTrain folder:  
o PLU_template.shp 
o ortho_1-2_1n_s_fl<FIPS>_2013_1.<ext> 

 
□ Zoom to PLU_template.shp  

 
 

□ Using ArcPad Data Manager, export fields from PLU_template.shp 
in a new customer folder (Datafor<your_last_name>), under 
GPS_Data.  Be sure to create an ArcPad document by entering 
a map name (e.g. T1234) in the dialog box 

 
□  Transfer customer folder from GPS_data to the Geo7x SD Card 

 
□ Optional: If Toolkit is available, open a customer folder and practice 

exporting a field from the Case PLU to a folder (e.g. 
DataForTestCust) as per instructions in this manual. 
 

End of Activity #2b 
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Activity #3a 
 

□ Using Geo7x, launch ArcPad document from customer folder 
DataFor<your_last_name> on SD Card 
 

□ Edit symbology of shapefile containing field boundary 
 

□ Load county ortho imagery under the geodata folder on SD card 
 

□ Save ArcPad document as prax_cert.apm 
 

□ Close ArcPad 
 

End of Activity #3a 
 

______________________________ 

Activity #3b 
 

□ Open ArcMap Editor: 
o If Toolkit is available, open Toolkit Training Customer, 

launch Toolkit_Template.mxd 
o If Toolkit is not available, launch ArcMap (click  > 

All Programs > ArcGIS > ArcMap) 
 

□ Add the following layers located in DataForGpsTrain folder:  
o partner_plu.shp 
o ortho_2-2_1n_s_fl<FIPS>_2013_1.<ext> 

 
□ Zoom to partner_plu.shp  

 

 
□ Without using using ArcPad Data Manager, export partner_plu 

shapefile into a new customer folder, DataforJaneDavis 
 

□ Transfer customer folder DataforJaneDavis  from GPS_data to the 
Geo7x SD Card 
 

□ Launch new ArcPad document on the Geo7x 
 

□ Load county ortho imagery under the geodata folder on SD card 
 

□ Add partner_plu.shp  located in DataForJaneDavis folder 
 

□ Zoom to the location of the shapefile 
 

□ Save ArcPad document as partner.apm under DataforJaneDavis 
 

□ Close ArcPad 
 

End of Activity #3b  
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Activity #4a 
 

□ Using Geo7x, launch partner.apm under DataforJaneDavis   
 

□ Load points.shp from MasterProject{16 or 17} 
  

□ Add a point within PLU boundary and enter attribute  
o Key Steps:  

 Put shapefile in edit mode 
 Select sketch tool 
 Digitize features  

 
□ Save ArcPad document  
 

End of Activity #4a 
 
 
 

______________________________ 
 
 
 

Activity #4b 
 

□ Load lines and polygons shapefiles from MasterProject{16 or 17} 
 

□ Add a fence and an area for nutrient management in each 
respective shapefile  
 

□ Delete point feature from Activity 4a 
 

□ Save ArcPad document  
 

□ Close ArcPad 
 

 
End of Activity #4b 
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Activity #5 
 

□ Check GPS Controller settings on Geo7x  
 

□ Check ArcPad Preferences settings on Geo7x  
 

End of Activity #5 
 

______________________________ 
 

 

Activity #6 
 

□ Fill in the blanks 
 

QUALITY OF POSITION INDICATORS RESOURCE 
INVENTORY 

PRACTICE 
CERTIFICATION 

GPS STATUS   
POSITIONING MODE   

POSITION DILUTION OF PRECISION    
SIGNAL STRENGTH OF EACH SATELLITE   
NUMBER OF SATELLITES IN SOLUTION   

DIFFERENTIAL DATA AGE (Maximum)   
HORIZONTAL ACCURACY   

 
 

End of Activity #6 
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Activity #7 
 In your group, list major steps involved in the process of preparing 

to carry out data collection using the Geo7x. 
 

□ _____________________________________________________ 
  

□ _____________________________________________________ 
 

□ _____________________________________________________ 
  

□ _____________________________________________________ 
 

□ _____________________________________________________ 
  

□ _____________________________________________________ 
 

□ _____________________________________________________ 
  

□ _____________________________________________________ 
 

□ _____________________________________________________ 
  

□ _____________________________________________________ 
 
 

      
 

 
 
 
 
 
 
 

 
End of Activity #7 
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Activity #8a 
 

□ Using Geo7x, launch partner.apm file from folder DataforJaneDavis  
  

□ Check collection QOP for compliance with Resource Inventory 
standards 
  

□ Record length of a feature using Continuous method 
 

□ Record length of same feature using GPS Capture Vertex method 
  

□ Is there a difference between length measurements obtained from 
those two methods?  Why? 
____________________________________________________ 
 
 ____________________________________________________ 
 
 

□ Record location of point, surface area of features in practice area 
□ Capture a photo of a feature in practice area 
 

 
End of Activity #8a 
 

 
______________________________ 

 

 

Activity #8b 
 

□ Using Geo7x, launch prax_cert.apm file from folder 
Datafor<your_last_name> 
  

□ Check collection QOP for compliance with Practice Certification  
standards 
  

□ Record location, length of designated features 
 

□ Record surface area of designated feature(s) 
 

□ Capture a photo of one or more certified practice 
 

End of Activity #8b 
 

 



 Technology Technical Note GIS & GPS FL-08 

 - 110 -  05/17/2016  

 

Activity #9a 
 

□ Copy MasterProject<utm_zone> from Geo7x to GPS_Data folder 
on workstation 
 

□ If Toolkit is not available, export certified features from 
MasterProject<utm_zone>  to shapefiles under C:\Users\<first 
name.last name>\ GPS_DATA\ Datafor<customer_name>  
folder  
 

□ If Toolkit is available, export certified features from 
MasterProject<utm_zone> to shapefiles under C:\Users\<first 
name.last name>\ My Customer Files 
Toolkit\<customer_folder>\Resource_Maps folder. 

  
□ Using Windows Explorer, copy photo(s) of certified practices to 

customer’s folder 
 
 

End of Activity #9a 
 
 

______________________________ 

 

Activity #9b 
 

□ Open an ArcMap document and calculate length and area 
measurements for features in practice certification shapefiles 
(customer name_<feature type>_cert.shp 
 

□ If Toolkit is available, create labels for features using the Map  
Labels tool for practice certification shapefiles.  Make sure such 
labels include units of measurements where appropriate. 
 

□ If Toolkit is not available, use ArcGIS shapefile properties’ label tab 
to create labels for features in practice certification shapefiles. 
Make sure such labels include units of measurements where 
appropriate.  
 

□ Create a hyperlink to a picture for a certified practice. 
  
 

End of Activity #9b 
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Activity #10 
 

□ If Toolkit is available, open ArcMap document and create layout for 
practice certification features using the ‘Map Products’ tool.  Make 
sure all the required elements are included, as per example on 
page 58. 
 

□ If Toolkit is not available, open ArcMap document and use the 
Layout View to create layout for practice certification features.  
Make sure all the required elements are included, as per example 
on page 59. 
 

□ Export layout to PDF or JPG file with your name as part of the 
filename.  Store file in assigned directory. 
  
 

End of Activity #10 
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